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第 1 章 简介

IBM® System Storage™ DS3000 Storage Manager V10（本文档中称为 Storage Man-

ager 软件）是一款可用于管理存储子系统的软件。

本文档介绍如何在以下基于 AMD 或 Intel® 处理器的各个操作系统中准备、安装、配
置及使用 Storage Manager 软件：

v Microsoft® Windows® Server 2003，带 Service Pack 2

v Microsoft Windows Server 2008

v Novell NetWare 6.5（仅适用于 DS3200 和 DS3400 存储子系统）

v Red Hat® Enterprise Linux® 5（RHEL 5）

v Red Hat Enterprise Linux Advanced Server 4.0（RHEL AS 4）

v SUSE Linux Enterprise Server 9（SLES 9）

v SUSE Linux Enterprise Server 10（SLES 10）和 SUSE Linux Enterprise Server 10

Service Pack 1

v VMware ESX Server 2.5.4、VMware ESX Server 3.0.1、VMware ESX Server

3.0.2、VMware ESX Server 3.5、VMware ESX Server 3.5.1 和 VMware ESX Server

3.5.2

有关列出了 Storage Manager 软件所支持的操作系统的互操作性矩阵，请参阅以下 Web

站点：

v 对于 DS3200：http://www.ibm.com/systems/storage/disk/ds3000/ds3200/

v 对于 DS3300：http://www.ibm.com/systems/storage/disk/ds3000/ds3300/

v 对于 DS3400：http://www.ibm.com/systems/storage/disk/ds3000/ds3400/

从 IBM 支持 Web 站点获取文档
您可以从 IBM 支持 Web 站点下载可用的固件和文档更新。Storage Manager 软件可能
具有设备随附文档中未描述的功能，并且该文档可能不定期更新以包含这些功能的相
关信息，或者可能新增技术更新来提供存储子系统文档中未包含的其他信息。要查看
更新，请完成以下步骤。

注：IBM Web 站点会定期进行更改。查找固件和文档的步骤可能与本文档中的描述略
有不同。

1. 转至 http://www.ibm.com/servers/storage/support/。

2. 在 Select your product 下的 Product family 字段中，单击 Disk systems。

3. 在 Product 字段中，根据情况单击 DS3200、DS3300 或 DS3400。

4. 单击 Go。

5. 进行以下选择：

v 要获取固件更新和自述文件，请单击 Support & downloads 下的 Down-
load。

v 要获取文档更新，请单击 Support & downloads 下的 Documentation。
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本文档中的注意事项
本文档中使用以下注意事项：

v 注：这些注意事项提供重要的提示、指导或建议。

v 要点：这些注意事项提供的信息或建议可能会帮助您避免不便情况或出现问题。

v 注意：这些注意事项指出可能对程序、设备或数据造成的损坏。注意事项就在可能
会发生损坏的说明或情况之前列出。

Storage Manager 软件联机帮助和诊断
安装完毕后，请查看以下联机帮助系统：

v Enterprise Management 窗口帮助

通过该联机帮助系统可进一步了解如何使用整个管理域。

v Subsystem Management 窗口帮助

通过该联机帮助系统可进一步了解如何管理各个存储子系统。

您可以在 Storage Manager Client 中访问这些帮助系统。在 Enterprise Management 或
Subsystem Management 窗口中，单击 Help 或按 F1。

光纤通道和 iSCSI 主机总线适配器诊断
在使用存储子系统之前，可以采用诊断应用程序来确保主机连接工作正常。

如果采用光纤通道主机总线适配器，那么在安装 Storage Manager 软件之后，请安装
QLogic SANsurfer Fibre Channel Management 工具或 Emulex HBAnywhere 实用程序。
如果采用 iSCSI 主机总线适配器，那么请安装 QLogic SANsurfer iSCSI HBA Man-

ager 工具。

您可以在以下站点上找到 QLogic SANsurfer 程序文件和 Emulex HBAnywhere 实用程
序文件：http://www.ibm.com/servers/storage/support/disk/。

高级功能部件
高级功能部件提供一些增强功能，您可以使用这些功能执行使用基本型号的存储子系
统执行时受限制或无法执行的任务。要获取更多信息，请参阅第 101页的第 10 章, 『启
用和使用高级功能部件』。

您可以购买 DS3000 存储子系统的以下高级功能部件：

v DS3000 FlashCopy 扩展许可证

v DS3000 卷拷贝许可证

v DS3000 FlashCopy 卷拷贝许可证

v DS3000 分区扩展许可证
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FlashCopy
FlashCopy 功能部件支持创建和管理 FlashCopy 逻辑驱动器。FlashCopy 逻辑驱
动器是存储子系统中另一个逻辑驱动器的逻辑时间点映像，称为基本逻辑驱动
器。FlashCopy 映像是完整物理副本的逻辑等价物，但它的创建速度快很多并且
所需的磁盘空间更少。

由于 FlashCopy 映像是主机可寻址逻辑驱动器，所以您可以在基本逻辑驱动器
保持联机并可供用户访问的情况下使用 FlashCopy 映像执行备份。您还可以写
入 FlashCopy 逻辑驱动器进行应用程序测试或方案开发和分析。允许的最大
FlashCopy 逻辑驱动器数是控制器型号支持的逻辑驱动器总数的一半。

VolumeCopy
VolumeCopy 功能部件是一个基于固件的机制，用于在存储器阵列中复制逻辑驱
动器数据。这个功能部件设计为一个系统管理工具，用于执行将数据转移到其
他驱动器以实现硬件升级、性能管理、数据备份或 FlashCopy 逻辑驱动器数据
复原等任务。

您可以通过指定两个兼容的驱动器来提交 VolumeCopy 请求。一个驱动器指定
作为“源驱动器”，而另一个指定作为“目标驱动器”。VolumeCopy 请求为持
久请求，因此复制进程的所有相关结果都会传递给您。

注：本文档、Storage Manager Client 程序界面和联机帮助中使用的术语
VolumeCopy 和逻辑驱动器复制可以互换。

分区扩展

您可以使用分区扩展功能，通过几个不同的分区向 SAN 提供存储子系统中的所
有已定义逻辑驱动器。只需将每个已定义分区中的各个逻辑驱动器映射到
LUN（0 - 31）即可实现这一目的。一个逻辑驱动器每次只能映射到一个分区。
在存储分区中，只有主机总线适配器的主机端口在该存储分区中进行了定义的
主机服务器才可以访问映射的逻辑驱动器。这个功能使 DS3000 存储子系统能
作为主机服务器的多重虚拟存储子系统。

分区扩展还允许多个使用不同操作系统且磁盘存储子系统设置各不相同的主机
同时连接到同一个 DS3000 存储子系统。这称为异构主机环境。
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需了解的术语
要获取有关术语的更多信息，请参阅 Storage Manager Enterprise Management 窗口或
Storage Subsystem Management 窗口中的联机帮助。

阅读本文档时，您需要理解以下两个术语之间的区别。

管理站 管理站是一种用于管理 DS3000 存储子系统的系统。您可以通过以下任何一种
方法将管理站连接到存储子系统：

v 通过连接到存储子系统中控制器的 TCP/IP 以太网连接（频带外方法）

v 通过与主机服务器上安装的主机代理软件的 TCP/IP 连接，该服务器通过输入/

输出（I/O）路径直接连到存储子系统（频带内方法）

要获取更多信息，请参阅第 7页的『存储子系统管理方法』。

主机服务器
主机服务器是通过 I/O 通路直接连接到 DS3000 存储子系统的服务器。它用于
执行以下任务：

v 提供来自存储子系统的数据（通常以文件形式提供）

v 充当远程管理站存储子系统的连接点

注：

1. 本文档中使用的术语主机和主机服务器可以互换。

2. 主机服务器还能用作管理站。

硬件要求
表 1 列出了安装 Storage Manager 2 软件的硬件要求。

表 1. Storage Manager 2 软件的硬件要求

硬件组件 要求

管理站（用于运行客户端软
件）

管理站计算机需要具备以下硬件：

v Intel Pentium® 或与 Pentium 相当的微处理器（450 MHz 或更
高频率）

v CD 驱动器

v 鼠标或类似的定位设备

v 对于 Windows Server 2003、Linux 和 NetWare 的系统内存：
至少 256 MB（建议 512 MB）

v 以太网网络接口适配器

v AGP 或 PCI 视频适配器（建议 AGP）；不支持 ISA 适配器

v 显示器设置为 1024 x 768 像素，64 000 色。允许的最低显示
设置为 800 x 600 像素，256 色。

v 基于硬件的视频加速。为了使 Storage Manager 软件的性能达
到最优，请勿使用将系统内存作为视频内存的台式计算机。

要点：某些服务器不是为运行图形密集型软件而设计的。如果您
的服务器无法正常显示 Storage Manager 用户界面，您可能需要
升级服务器视频适配器。

4 DS3000 Storage Manager Windows、Linux、NetWare 和 VMware 版安装和支持指南



要获取有关主机适配器、光纤网交换机和受管集线器的更多信息，请访问以下
ServerProven® 和互操作性 Web 站点：

http://www.ibm.com/servers/eserver/serverproven/compat/us/

http://www.ibm.com/systems/storage/disk/ds3000/ds3200/

http://www.ibm.com/systems/storage/disk/ds3000/ds3300/

http://www.ibm.com/systems/storage/disk/ds3000/ds3400/

Microsoft Windows 软件要求
以下部分描述 Storage Manager 软件要求和 Microsoft Windows 操作系统要求。

Storage Manager 软件要求
表 2 列出在 Windows 环境中安装 Storage Manager 软件所需的磁盘空间和管理员权限。

注：表 2 中列出的磁盘空间用于安装后的软件包。在每个软件包的安装过程中，您可能
需要 150 MB 可用磁盘空间。

表 2. Windows Server 2003 和 Windows Server 2008 的安装要求（按软件包）

软件包

Windows Server 2003 和
Windows Server 2008 的磁盘空间
要求

Windows Server 2003 和
Windows Server 2008 的管理员权
限

SMclient 130 MB 不需要管理员权限。

MPIO 2 MB 需要管理员权限。

SMagent 1 MB

50 MB（如果不安装 SMclient）

需要管理员权限。

SMutil 2 MB 需要管理员权限。

Windows 操作系统要求
每个管理站、主机服务器或集群节点必须使用以下某种操作系统。

要点：要了解最新的受支持操作系统和主机软件版本，请阅读 Storage Manager 自述文
件并访问 http://www.ibm.com/servers/eserver/serverproven/compat/us/。

管理站

v Microsoft Windows Server 2003 或 Windows Server 2008（Web Edition）

v Microsoft Windows Server 2003 或 Windows Server 2008（Standard Edition）

v Microsoft Windows Server 2003 或 Windows Server 2008（Enterprise Edition）

v Microsoft Windows XP（Professional Edition）

v Microsoft Windows Vista（Business 或 Enterprise Edition）

主机服务器

v Microsoft Windows Server 2003 或 Windows Server 2008（Web Edition）

v Microsoft Windows Server 2003 或 Windows Server 2008（Standard Edition）
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v Microsoft Windows Server 2003 或 Windows Server 2008（Enterprise Edition）

集群节点

v Microsoft Windows Server 2003 或 Windows Server 2008（Enterprise Edition）

注：对于 Windows Server 2003 版本，必须安装 Service Pack 2 或更高版本。

Linux 软件要求
以下部分描述 Storage Manager 软件要求和 Linux 操作系统要求。

Storage Manager 软件要求
表 3 列出在 Linux 环境中安装 Storage Manager 软件所需的磁盘空间。

表 3. Linux 的安装要求（按软件包）

软件包 磁盘空间要求

Storage Manager Client（SMclient） /opt 中 165 MB，/tmp 中 2 MB，/var 中 1

MB

Linux MPP 2 MB

Storage Manager Agent（SMagent） /opt 中 2 MB

Storage Manager Utility（SMutil） /opt 中 7 MB

Linux 操作系统要求
Linux 操作系统需要以下内核级别：

v 2.6 内核（RHEL 4、SLES 9 和 SLES 10）（适用于 RDAC 修订版 B）

v 2.6 内核（RHEL 5 和 SLES 10 SP1）（适用于 RDAC 修订版 C）

要了解最新的受支持 Linux 操作系统、关于设备驱动程序级别的详细信息以及 Linux 支
持多路径配置的指示信息，请参阅 Storage Manager 软件自述文件。

NetWare 软件要求
下面描述 Storage Manager 软件要求和 Novell NetWare 操作系统要求。

注：本文档发布时，DS3300 存储子系统不支持 Novell NetWare 操作系统。

Storage Manager 软件要求
管理 DS3000 存储子系统所需的 Storage Manager 软件不能用于 NetWare 操作系统环
境。

要管理连接到 NetWare 主机服务器的 DS3000 存储子系统，必须在管理站上安装 Win-

dows 或 Linux 版的 Storage Manager SMclient 程序，并建立与 DS3000 存储子系统
的频带外管理连接。

要点：要了解特定设备驱动程序级别的详细信息以及 NetWare 支持多路径配置的指示信
息，请参阅自述文件。
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表 4 列出在 NetWare 主机环境中安装 Storage Manager 软件所需的磁盘空间。

表 4. NetWare 的安装要求（按软件包）

软件包 磁盘空间要求

LSIMPE.cdm 驱动程序 2 MB

主机总线适配器设备驱动程序 2 MB

NetWare 操作系统要求
每个管理站、主机服务器或集群节点必须使用以下某种操作系统。

要点：要了解最新的受支持操作系统和主机软件版本，请阅读 Storage Manager 自述文
件并访问 http://www.ibm.com/servers/eserver/serverproven/compat/us/。

管理站

v Widows Vista

v Windows XP

v 带 Service Pack 2（SP 2）或更高版本的 Windows Server 2003

v Windows Server 2008

v Red Hat Enterprise Linux 4 或 Red Hat Enterprise Linux 5（RHEL 4 或 RHEL 5）

v SUSE Linux Enterprise Server 9 或 SUSE Linux Enterprise Server 10（SLES 9 或
SLES 10）

主机服务器（仅适用于 I/O 连接）
Novell NetWare 6.5，带 Support Pack 6 或更高版本

集群节点（仅适用于 I/O 连接）
Novell NetWare 6.5，带 Support Pack 6 或更高版本

LSIMPE 驱动程序
LSIMPE.cdm

注：请确保已安装 LSIMPE 多路径驱动程序的正确版本。要了解更多信息，请参阅第
56页的『安装 LSIMPE 设备驱动程序和 NetWare 本机故障转移设备驱动程序』。

最新的 IBM 主机总线适配器 NetWare 驱动程序、Novell NetWare Support Pack 或
Novell Web 站点均提供该组件版本。确保选择该组件的最新版本。

注：在 Novell NetWare 环境中，必须从 Windows 或 Linux 管理站使用直接（频带外）
方法管理 DS3000 存储子系统。

存储子系统管理方法
Storage Manager 软件提供以下两种存储子系统管理方法：

v 主机代理（频带内）管理方法（仅适用于 DS3300 和 DS3400）

v 直接（频带外或以太网）管理方法

如果在多个管理站或主机与同一个 DS3000 存储子系统之间建立管理连接，虽然 DS3000

存储子系统同时支持八个活动的管理会话，但是与 DS3000 存储子系统之间最好在同一
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时间只有一个活动的管理连接。
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主机代理（频带内）管理方法（DS3200 不支持此方法）
使用主机代理（频带内）管理方法时，通过主机的 I/O 通路来管理存储子系统。如图 1

所示，既可在主机内处理管理信息，也可以通过网络连接将这些信息传递到管理站。

注：本文档发布时，DS3200 尚不支持频带内管理。

通过主机代理管理存储子系统具有以下优点：

v 不需要将以太网电缆连接到控制器。

v 不需要动态主机配置协议/引导协议（DHCP/BOOTP）服务器即可将存储子系统连接
到网络。

v 不需要执行第 21页的第 2 章, 『准备安装』中描述的控制器网络配置任务。

v 只需为该主机、而不必为存储子系统中的各个控制器指定主机名或 IP 地址。如果主
机代理服务已安装且正在运行，系统将自动发现连接到该主机的存储子系统。

通过主机代理管理存储子系统具有以下缺点：

v 主机代理需要一个称为访问逻辑驱动器的特殊逻辑驱动器来与存储子系统中的控制
器通信。因此，操作系统以及所用主机适配器可配置的逻辑驱动器数比允许的最大
数少一个。

v 如果主机与存储子系统之间通过 I/O 通路进行的连接已断开，就无法管理或监控存储
子系统。

注：访问逻辑驱动器又称为通用 Xport 设备。

要点：如果在主机中已配置最大数量的逻辑驱动器，请使用直接管理方法，或腾出一
个逻辑驱动器用作访问逻辑驱动器。要获取更多信息，请参阅第 18页的『支持
的逻辑驱动器数』。

图 1. 主机代理（频带内）管理存储子系统
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必需的主机代理（频带内）管理活动
要建立主机代理（频带内）管理连接，请完成以下常规任务：

1. 在 DS3000 存储子系统与主机服务器之间建立 I/O 连接。

2. 在主机服务器上安装 TCP/IP 并确定主机 IP 地址。要获取有关主机管理系统的指示
信息，请参阅第 23页的『网络安装任务概述』。

3. 在主机服务器上安装主机总线适配器设备驱动程序、SMclient、RDAC（用于 Win-

dows 的 MPIO 和用于 Linux 的 Linux MPP）以及 SMagent。

4. 确保 Storage Manager Agent Service 成功启动：

对于 Windows：

a. 单击开始 → 设置 → 控制面板 → 管理工具 → 服务。这时将打开“服务”窗口。

b. 定位 IBM System Storage DS3000 Storage Manager 2 Agent，确保其状态为“已
启动”。

对于 Linux：输入 ps -elf | grep SMagent 并确保 Java 侦听服务正在运行。

5. 打开 Storage Manager Enterprise Management 窗口并将主机服务器的 IP 地址添加
到管理域中。Enterprise Management 窗口中将显示主机服务器识别出的所有 DS3000

设备。
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直接管理（频带外）方法
使用直接管理（频带外）方法时，您在网络上通过与每个控制器的 TCP/IP 以太网连接
直接管理存储子系统。要通过以太网连接管理存储子系统，您必须为每个控制器定义 IP

地址和主机名。每个存储子系统控制器必须通过连接至 RJ-45 接口的电缆连接到一个以
太网络，如图 2 所示。

下图所示的系统使用直接管理（频带外）方法来管理存储子系统。

使用直接管理（频带外）方法管理存储子系统具有以下优点：

v 如果主机运行 Storage Manager 支持的任何一种操作系统，那么与控制器之间的以太
网连接使您能够通过 SMclient 管理站管理连接到该主机的存储子系统。

v 您不需要访问逻辑驱动器即可与控制器进行通信。可以配置操作系统以及所使用的
主机总线适配器支持的逻辑驱动器最大数。

v 当光纤通道、因特网 SCSI（iSCSI）或 SAS 链路出现问题时，您可以管理存储子系
统并对它进行故障诊断。

使用直接管理（频带外）方法管理存储子系统具有以下缺点：

v 在双控制器存储子系统配置中，您需要使用两根以太网电缆将存储子系统控制器连
接到网络。

v 添加设备时，必须为每个控制器指定 IP 地址或主机名。

v 需要执行网络准备任务。要获取准备任务的摘要信息，请参阅第 21页的第 2 章, 『准
备安装』。

要点：

图 2. 直接管理（频带外）存储子系统

第 1 章 简介 11



v 为了省去 DHCP/BOOTP 服务器和网络任务，请使用控制器缺省 TCP/IP 地址
或为控制器指定静态 IP 地址（请参阅表 5）。

v 创建一个独立于主生产网络的专用网络，用于管理 DS3000 存储子系统。

定义控制器 TCP/IP 地址
下表显示存储子系统控制器的缺省设置。

表 5. 缺省控制器 TCP/IP 地址

控制器 IP 地址 子网掩码

A 192.168.128.101 255.255.255.0

B 192.168.128.102 255.255.255.0

要更改 DS3000 存储子系统控制器的缺省 TCP/IP 地址，您首先必须使用缺省 TCP/IP

地址与存储子系统建立直接管理连接。

要使用 Storage Manager Client 程序更改控制器缺省 TCP/IP 地址，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击要定义新控制器 TCP/IP 地址的存储子系统。
这时将打开 Subsystem Management 窗口。

2. 单击 Tools 选项卡。

3. 在 Tools 页面中，单击 Change Network Configuration。这时将打开 Change Net-

work Configuration 窗口。

4. 选择适当的控制器选项卡，并为控制器 A 和 B 输入相应的 TCP/IP 地址信息。

5. 单击 OK 应用新的 TCP/IP 地址。

要点：确保新的 TCP/IP 地址信息正确无误，因为将它们更改为不同的值后，您无法
再使用控制器缺省 TCP/IP 地址与存储子系统建立直接管理连接。

6. 关闭 Subsystem Management 窗口。

图 3. Change Network Configuration 窗口
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7. 在 Enterprise Management 窗口中，删除包含缺省 TCP/IP 地址的存储子系统条目。

8. 等待 5 分钟左右，然后使用新的 TCP/IP 地址与存储子系统重新建立管理连接。

注：可以首先 ping 新地址，确保与控制器的网络连接情况良好，然后将存储子系统
添加到 Enterprise Management 窗口中。

必需的直接管理（频带外）管理活动

要建立直接管理连接，请完成以下步骤：

1. 在 DS3000 存储子系统与以太网络之间建立以太网连接。

2. 按照第 23页的『网络安装任务概述』中直接管理系统的指示信息进行操作。

3. 安装 SMclient。

4. 启动 Storage Manager 软件并添加 DS3000 控制器（A 和 B）的 IP 地址。如果有
多个 DS3000 存储子系统，请将每个 IP 地址添加到域中。
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查看样本网络
下图显示一个网络示例，它包含直接管理存储子系统（网络 A）和主机代理管理存储子
系统（网络 B）。

直接管理存储子系统

在图 4 中，网络 A 是直接管理存储子系统。它包含以下组件：

v 一台 DHCP/BOOTP 服务器

v 一个用于简单网络管理协议（SNMP）陷阱的网络管理站（NMS）

v 一台通过光纤通道、iSCSI 或 SAS I/O 通路连接到存储子系统的主机

v 一个通过以太网电缆连接到存储子系统控制器的管理站

注：如果您使用控制器静态 TCP/IP 地址或缺省 TCP/IP 地址，就不必设置 DHCP/

BOOTP 服务器。

图 4. 使用直接管理和主机代理管理存储子系统的样本网络
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主机代理管理存储子系统

在第 14页的图 4 中，网络 B 是主机代理管理存储子系统。网络 B 包含以下组件：

v 一台通过有效 I/O 通路连接到存储子系统的主机

v 一个通过以太网电缆连接到主机服务器的管理站

软件组件安装位置
存储子系统的管理方式可以决定各个软件组件的安装位置。

管理站
必须在每个管理站上安装 SMclient 组件。

主机服务器
必须在每台主机服务器上安装以下软件组件。

表 6. 必需的主机软件组件

操作系统 RDAC SMutil LSIMPE
QLogic SANsurfer 或
Emulex HBAnywhere

Linux 是（见注 1） 是 是（见注 2）

W i n d o w s S e r v e r

2003 或 Windows

Server 2008

是（见注 4） 是 是（见注 2）

NetWare 是

V M W a r e E S X

Server

见注 3。

注：

1. Linux 将 Linux MPP 用作多路径驱动程序。要获得详细的 Linux MPP 安装说明，
请参阅第 49页的『安装 Linux MPP』。

2. 仅使用 Qlogic SANsurfer 或 Emulex HBAnywhere 管理 IBM 光纤通道主机总线适
配器，并对主机服务器主机总线适配器与 DS3400 存储子系统之间光纤通道路径中
的问题进行故障诊断。

3. 本文档发布时，Storage Manager 软件还不能用于 VMware ESX Server 操作系统。
VMware 为多路径操作提供一个内建设备驱动程序。

4. Windows 将 Storage Manager RDAC（MPIO DSM）用作多路径驱动程序。

根据您要对存储子系统使用的管理方式，可能还需要安装以下附加主机软件组件：

v SMclient（Windows Server 2003 和 Linux）

v SMagent（Windows Server 2003 和 Linux [仅具有 Linux MPP]）

注：

1. 如果要使用主机代理管理方法来管理 DS3400 存储子系统，请在主机服务器上安装
SMagent。

2. 如果要将主机服务器用作管理站，必须在主机服务器上安装 SMclient。如果主机服务
器未连接到网络，必须安装 TCP/IP 软件并指定 IP 地址。
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创建 SAN 连接的配置（光纤通道）
本部分包含以下主题：

v 准备 SAN 连接的配置

v SAN 连接的配置的设置步骤

v 在光纤通道交换机环境中连接主机总线适配器

准备 SAN 连接的配置
创建 SAN 连接的配置之前，请阅读以下信息：

v 确保同一个服务器中的多个主机总线适配器不会“看到”同一个 DS3400 控制器端
口。

v 多路径配置要求每个主机系统有两个主机总线适配器，分别位于连接到两个控制器
之一的独立交换机区域中。

v 如果各个主机上的每个光纤通道主机总线适配器和各个 DS3000 存储子系统上的控制
器端口通过一个光纤通道交换机进行连接，那么它们应该位于自己的光纤网区域
中。如果多个适配器或控制器端口在同一个区域中，由于会在整个区域中传播设备
复位，因此您可能会遇到扩展性故障转移延迟或其他的故障转移问题。

注：允许使用单个主机总线适配器配置。如果一个 SAN 连接的配置中有一个主机总线
适配器，那么控制器必须通过交换机以光纤通道连接方式连接到主机总线适配
器，并且两个控制器必须与主机总线适配器位于同一个 SAN 区域中。

警告： 如果某个主机总线适配器配置中的路径出现问题，那么可能无法访问数据。

设置 SAN 连接的配置
要设置 SAN 连接的配置，请完成以下步骤：

1. 将主机总线适配器连接到一个或多个交换机。

2. 将 DS3000 存储子系统连接到一个或多个交换机。

3. 根据具体情况，在一个或多个光纤通道交换机上设置所需区域。

注：要获取有关分区和启用区域的信息，请参阅交换机随附的文档。

4. 配置系统，然后登录交换机并查看系统来验证配置。

要获取有关设置 DS3000 存储子系统的更多信息，请参阅存储子系统随附的支持 CD 中
的 Quick Installation Guide 和其他文档。

在光纤通道交换机环境中连接主机总线适配器
当您在光纤通道交换机环境中将主机服务器中的光纤通道主机总线适配器连接到 DS3000

存储子系统主机端口时，您应该在主机总线适配器与 DS3000 主机端口之间建立一对一
的区域关系。如果多个适配器或控制器端口在同一个区域中，由于会在整个区域中传
播设备复位，因此您可能会遇到扩展性故障转移延迟或其他的故障转移问题。

要获取在光纤通道交换机中设置区域的指示信息，请参阅光纤通道交换机随附的文
档。

您可以在 http://www.ibm.com/servers/storage/support/san/index.html 找到交换机文档的链
接。
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配置类型
您可以在以下两种配置中安装 Storage Manager 软件：

v 标准（非集群）配置

v 集群服务器配置

注：以下部分中的集群服务器配置插图不适用于 NetWare 或 Linux。

标准（非集群）配置
图 5 显示标准（非集群）配置样本。

图 5. 标准（非集群）配置样本
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用于 Windows 的集群服务器配置
图 6 显示集群服务器配置样本。

支持的逻辑驱动器数
对于 Windows Server、Linux 和 NetWare，所支持的逻辑驱动器数的限制如下：

v 如果使用 IBM 主机总线适配器及其受支持的设备驱动程序，Windows Server 最多支
持 255 个 LUN（LUN 0 至 254）。

v 如果使用 IBM 主机总线适配器及其受支持的设备驱动程序，Linux 最多支持每个存
储子系统 256 个逻辑驱动器（LUN 0 至 255）。

要了解主机服务器中支持的最大逻辑驱动器数以及可从存储子系统映射的最大逻辑
驱动器数，请参阅 Linux 内核文档。

v 如果使用 IBM 主机总线适配器及其受支持的设备驱动程序，带 SP3 或更高版本的
NetWare 6.5 最多支持每个存储子系统 256 个逻辑驱动器（LUN 0 至 255）。

v 第 19页的表 7 中列出 DS3000 存储子系统支持的最大逻辑驱动器数。

图 6. 集群服务器配置样本
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表 7. 每个存储子系统的最大逻辑驱动器数

最大逻辑驱动器数
每个存储单元分区的最
大逻辑驱动器数

最大 FlashCopy 逻辑
驱动器数

最大逻辑驱动器副本
逻辑驱动器数

256 32（见注 1。） 128 255

注：

1. 基本型号的 DS3000 最多支持 4 个分区。要从 4 个分区升级至 16 个分区，您必
须购买 DS3000 分区扩展许可证。

2. 每个标准逻辑驱动器最多支持 4 个 FlashCopy 逻辑驱动器。

3. 主机代理管理方法使用一个称为访问逻辑驱动器的特殊逻辑驱动器来与存储子系统
中的控制器通信。访问逻辑驱动器使用一个可用的 LUN。因此，使用主机代理软件
管理存储子系统时，可配置的 LUN 比操作系统和主机适配器支持的最大数少一个。
访问逻辑驱动器又称为通用 Xport 设备。

要点：在 Windows Server 2003 或 NetWare 环境中，FlashCopy 逻辑驱动器不能添加
或映射到拥有 FlashCopy 逻辑驱动器的基本逻辑驱动器的同一台服务器。您必须
将 FlashCopy 逻辑驱动器映射到另一台服务器。
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第 2 章 准备安装

本章提供相关信息，帮助您规划 Storage Manager 软件的安装。

请参阅本文档中的相应部分，以便在特定操作系统中安装 Storage Manager 2 Client 和
主机软件。完成 Storage Manager 2 软件组件安装过程后，执行第 65页的第 8 章, 『完
成 Storage Manager 软件的安装和配置』和第 97页的第 9 章, 『完成 Windows 主机
的存储管理任务』中的过程。

规划和准备 Windows 安装
表 8 显示 Storage Manager 软件组件的安装顺序，并提供相关信息帮助您规划 Win-

dows Server 2003 版或 Windows Server 2008 版 Storage Manager 软件的安装。

表 8. Windows 环境中的软件组件安装顺序

系统类型 软件安装顺序

管理站 SMclient

主机服务器和集群节
点

1. IBM 主机总线适配器设备驱动程序

2. Microsoft Windows Server 2003 Service Pack 2（SP2）

3. Microsoft 最新修订程序 KB932755（仅适用于 Windows Server 2003）

4. Storage Manager 主机软件包，它可以安装以下组件：

v SMclient（可选）

如果要从主机服务器管理存储子系统，就需要 SMclient。

v MPIO（必需）

MPIO（又称为 MPIO DSM）作为 RDAC 故障转移驱动程序 Win-

dows Server 2003 版或 Windows Server 2008 版进行安装。

v SMagent（可选）

如果您在 Storage Manager 安装向导中选择 Typical Installation
选项，将安装 SMagent。如果要使用主机代理管理方法，就需要
它。

v SMutil（必需）

SMutil 包含 hot_add、SMdevices 和 SMrepassist 实用程序。

5. 主机总线适配器管理软件（仅光纤通道）
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规划和准备 Linux 安装
表 9 显示 Storage Manager 软件组件的安装顺序，并提供相关信息帮助您规划 Linux 版
存储管理软件的安装。

表 9. Linux 环境中的软件组件安装顺序

系统类型 软件安装顺序

管理站（以及用作管
理站的任何主机服务
器）

Storage Manager Client（SMclient）

请参阅第 47页的『使用安装向导安装 Storage Manager 2 软件』。

主机服务器和集群节
点

1. IBM 主机总线适配器设备驱动程序（Linux 版）

2. Linux MPP（必需）

Linux MPP 作为用于 Linux 的 RDAC 故障转移驱动程序进行安装。

请参阅第 48页的『Linux MPP 软件包』。

3. Storage Manager 主机软件包，它可以安装以下组件：

v SMclient（可选）

如果要从主机服务器管理存储子系统，就需要 SMclient。

v SMagent（可选）

如果要使用主机代理（频带内）管理方法，就需要 SMagent。您必须
先安装 Linux MPP（请参阅步骤 2）。直接（频带外）管理方法是
Linux 环境中的首选方法。

请参阅第 47页的『使用安装向导安装 Storage Manager 2 软件』。

v SMutil（必需）

SMutil 包含 hot_add、SMdevices 和 SMrepassist 实用程序。

4. （可选）主机总线适配器管理软件和 QLRemote 代理（仅适用于
QLogic SANsurfer）

完成该步骤可实现光纤通道主机总线适配器诊断功能。请参阅主机总
线适配器随附的安装文档。

注：Linux MPP 与 Storage Manager 主机软件包分别提供。Linux MPP 软件包有两个，
分别用于不同类型的内核：

v 2.6 内核（RHEL 4、SLES 9 和 SLES 10）（适用于 RDAC 修订版 B）

v 2.6 内核（RHEL 5 和 SLES 10 SP1）（适用于 RDAC 修订版 C）

规划和准备 NetWare 安装
Storage Manager 软件不能用于 NetWare 操作系统环境。

要管理连接到 NetWare 主机服务器的 DS3000 存储子系统，必须在管理站上安装 Win-

dows 或 Linux 版的 Storage Manager SMclient 程序，并建立与 DS3000 存储子系统
的频带外管理连接。
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表 10 显示 Storage Manager 软件组件的安装顺序，并提供相关信息帮助您规划存储管
理软件的安装。

表 10. Novell NetWare 6.5 环境中的软件组件安装顺序

系统类型 软件安装顺序

管理站（仅适用于
Windows 或 Linux 管
理站）

Storage Manager Client（SMclient）

NetWare 主机服务器
和集群节点

1. Novell NetWare 本机故障转移设备驱动程序（MM.NLM）

2. LSIMPE.cdm 驱动程序

3. 主机总线适配器设备驱动程序

4. （可选）主机总线适配器管理软件的 NetWare 代理组件

网络安装任务概述
要开始安装存储管理软件，请确保网络组件已正确安装并且运行正常，同时已获得正
确运行软件所需的主机和控制器信息。

以下部分概述了为直接管理存储子系统和主机管理存储子系统设置网络安装需要执行
的任务。

直接管理存储子系统：网络安装概述
设置直接管理系统的网络安装需要完成以下常规任务：

1. 安装要连接到网络的所有硬件组件（主机服务器、存储子系统和电缆）。欲了解安
装信息，请参阅特定硬件设备随附的文档。

2. 为连接到网络的存储子系统制订命名约定。要获取更多信息，请参阅第 24 页的
『步骤 1：命名存储子系统』。

3. 将存储子系统名称和管理类型记录在第 105页的附录 A, 『存储子系统和控制器信息
记录』中。第 25页的表 11 显示已完成信息记录的示例。

注：在后面的步骤中，返回到第 105页的附录 A, 『存储子系统和控制器信息记录』
并记录硬件以太网地址和 IP 地址等信息。

4. 如果使用缺省控制器 IP 地址，请转至步骤 第 24页的 6。否则，请从网络管理员处
获取网络中存储子系统各控制器的 TCP/IP 地址和主机名。请参阅第 25页的『步骤
3：指定主机和控制器 IP 地址』。

5. 使用控制器静态 IP 地址（建议）；否则请设置一台 DHCP/BOOTP 服务器，提供
特定控制器的网络配置信息。
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6. 确保已安装 TCP/IP 软件。要获取更多信息，请参阅第 28页的『步骤 5（适用于
Windows Server 2003 和 Windows Server 2008）：验证 TCP/IP 协议并设置主机或
DNS 表』。

7. 开启连接到网络的设备。

主机管理系统：网络安装概述
以下步骤概述了为主机管理系统设置网络安装需要执行的任务：

1. 安装要连接到网络的所有硬件组件（主机服务器、存储子系统和电缆）。欲了解安
装信息，请参阅特定硬件设备随附的文档。

2. 为连接到网络的存储子系统制订命名约定。要获取更多信息，请参阅『步骤 1：命名
存储子系统』。

3. 将存储子系统名称和管理类型记录在第 105页的附录 A, 『存储子系统和控制器信息
记录』中。第 25页的表 11 显示已完成信息记录的示例。

注：在后面的步骤中，返回到第 105页的附录 A, 『存储子系统和控制器信息记录』
并记录硬件以太网地址和 IP 地址等信息。

4. 从网络管理员处获取运行主机代理软件的主机服务器的 IP 地址和主机名。请参阅第
25页的『步骤 3：指定主机和控制器 IP 地址』。

注：只有 DS3300 和 DS3400 支持主机管理的存储子系统。

5. 确保已安装 TCP/IP 软件。要获取更多信息，请参阅第 28页的『步骤 5（适用于
Windows Server 2003 和 Windows Server 2008）：验证 TCP/IP 协议并设置主机或
DNS 表』。

6. 开启连接到网络的设备。

步骤 1：命名存储子系统
设置网络时，请确定存储子系统的命名约定。当您安装存储管理软件并第一次启动它
时，管理域中的所有存储子系统都显示为 <unnamed>。请使用 Subsystem Management 窗
口重命名各个存储子系统。

命名存储子系统时请注意以下几点：

v 名称有 30 个字符的限制。名称中的所有头部和尾部的空格都会被删除。

v 使用容易理解和记忆、独一无二并且有意义的命名规则。

v 避免使用可能很快失去意义的随意确定的名称。

v 软件在显示存储子系统名称时会添加前缀 Storage Subsystem。例如，如果将一个存
储子系统命名为 Engineering ，它显示为 Storage Subsystem Engineering。

步骤 2：记录存储子系统名称
确定命名规则后，将存储子系统名称记录在第 105页的附录 A, 『存储子系统和控制器
信息记录』的空白信息记录表单中。

第 25页的表 11 显示第 14页的图 4 中所示网络的信息记录样本。该网络包含使用直接
管理和主机代理管理方法管理的多个存储子系统。
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表 11. 信息记录样本

存储子系统名称 管理方法 控制器：IP 地址和主机名 主机 IP 地址和主
机名控制器 A 控制器 B

Finance 直接管理 IP 地址 =

192.168.128.101

IP 地址 =

192.168.128.102

主机名 =

Denver_a

主机名 =

Denver_b

Engineering 主机代理管理 IP 地址 =

192.168.2.22

主机名 = Atlanta

步骤 3：指定主机和控制器 IP 地址
如果准备使用频带外管理（直接管理）方法来管理存储子系统，请为网络中所有存储
子系统的每个控制器指定一个唯一的 IP 地址。在信息记录（第 105页的附录 A, 『存
储子系统和控制器信息记录』）中记下各个控制器的 IP 地址。然后转至第 26页的『步
骤 4：设置 Windows Server 2003 或 Windows Server 2008 DHCP 或 BOOTP 兼容服
务器』。

注：为了省去 DHCP/BOOTP 服务器和网络任务，请使用控制器缺省 TCP/IP 地址或为
控制器指定静态 IP 地址。如果无法使用控制器缺省 TCP/IP 地址指定静态 TCP/IP

地址，请参阅第 11页的『直接管理（频带外）方法』中的信息。

然后转至第 28 页的『步骤 5（适用于 Windows Server 2003 和 Windows Server

2008）：验证 TCP/IP 协议并设置主机或 DNS 表』。

您可以对控制器 A 使用缺省 IP 地址 192.168.128.101，对控制器 B 使用
192.168.128.102，从而与 DS3000 存储子系统建立频带外管理连接。可通过 Storage Man-

ager Client Subsystem Management 窗口更改 IP 地址。

仅适用于主机代理管理：如果准备使用主机代理管理方法来管理 DS3300 或 DS3400 存
储子系统，请为将安装主机代理软件的每台主机分配 IP 地址。在第 105页的附录 A,

『存储子系统和控制器信息记录』中的信息记录中记下各台主机的 IP 地址；然后转至
第 28页的『步骤 5（适用于 Windows Server 2003 和 Windows Server 2008）：验证
TCP/IP 协议并设置主机或 DNS 表』。
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步骤 4：设置 Windows Server 2003 或 Windows Server 2008 DHCP
或 BOOTP 兼容服务器

要通过到各个控制器的以太网连接直接管理存储子系统，您可以设置 DHCP 或 BOOTP

兼容服务器并配置以下选项：

v 路由器/网关

v DNS 服务器

v 主机名

v DNS

本部分说明了如何在 Windows Server 2003 或 Windows Server 2008 上设置 DHCP 服
务器。

您必须使用支持 BOOTP 静态寻址的 DHCP 版本。要使用 DHCP 服务器，必须安装
DHCP Manager。如果系统中已安装 DHCP Manager，请参阅第 27页的『在 Windows

Server 2003 上创建作用域并设置 DHCP 服务器』。

针对 Windows Server 2003 安装 DHCP Manager
要安装 DHCP Manager，请完成以下步骤：

1. 单击开始 → 控制面板 → 添加或删除程序。这时将打开“添加或删除程序”窗口。

2. 在左侧窗格中，单击添加/删除 Windows 组件。这时将打开“Windows 组件向导”
窗口。

3. 在组件字段中，选中网络服务。然后单击详细信息。这时将打开“网络服务”窗
口。

注：请勿选中复选框；不需要安装所有“网络服务”子组件。

4. 在网络服务的子组件字段中，选中动态主机配置协议（DHCP）。单击确定。

5. 在“Windows 组件向导”窗口中，单击下一步开始安装。

6. 如果出现提示，请输入 Windows Server 2003 分发版文件的完整路径并单击继续。

7. 在安装成功完成并显示“Windows 组件向导”窗口后，单击完成。

8. 关闭“添加或删除程序”窗口。现在可以执行第 27页的『在 Windows Server 2003

上创建作用域并设置 DHCP 服务器』中的任务。

安装 DHCP Manager 后，请参阅 DHCP Manager 联机帮助以获取更多信息。
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在 Windows Server 2003 上创建作用域并设置 DHCP 服务器
作用域按 IP 地址定义一组控制器。您必须创建并配置一个作用域，以便为网络中的控
制器指定动态 IP 地址。请参阅第 105页的附录 A, 『存储子系统和控制器信息记录』。
开始之前，请阅读指示信息以确定所需的信息。然后从网络管理员处获取相关信息。

要创建作用域并设置 DHCP 服务器，请完成以下步骤：

1. 单击开始 → 管理工具 → DHCP。这时将打开 DHCP 窗口。

2. 在控制台树中，右键单击要配置的服务器，然后单击新建作用域。这时将打开
“新建作用域向导”。

3. 按照屏幕上的指示信息定义 TCP/IP 客户机的 IP 地址作用域。您将定义以下字段：

v 作用域名称和描述

v 所配置控制器的 IP 地址范围和子网掩码

v 要从 IP 地址范围中排除的 IP 地址

v IP 地址租期

v 常见 DHCP 选项：

– 路由器 IP 地址

– 域名和 DNS 服务器或 Windows 因特网命名服务（WINS）服务器

4. 定义作用域后，单击是，我想现在激活此作用域。这时将打开“新建作用域向
导”窗口。

5. 单击完成。这时将打开 DHCP 窗口。

6. 在控制台树中，展开“作用域”文件夹。

7. 右键单击保留。然后选择新建保留。这时将打开“新建保留”窗口。

8. 要定义 IP 地址保留，请输入以下信息：

v 保留名称

v IP 地址

v 以太网硬件 MAC 地址

v 描述

9. 在支持类型字段中，选择两者（DHCP 和 BOOTP）。

10. 单击 Add。

11. 为网络中的每个控制器重复步骤 7 至 10。

12. 重新启动 DHCP 服务器，然后重新启动存储子系统，使所有修改生效。

13. 转至第 28页的『步骤 5（适用于 Windows Server 2003 和 Windows Server 2008）：
验证 TCP/IP 协议并设置主机或 DNS 表』。
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针对 Windows Server 2008，安装 DHCP 服务器并创建作用域
要安装和配置 DHCP Manager，请完成以下步骤：

1. 单击开始 → 控制面板。这时将打开“控制面板”窗口。

2. 单击 Turn Windows features on or off。这时将打开“Server Manager”窗口。

3. 在 Roles Summary 部分，选择 Add Roles。这时将打开“Add Roles Wiz-

ard”窗口。单击 Next。

4. 在 Select Server Roles 部分中，选择 DHCP (Dynamic Host Configuration
Protocol) Server，然后单击 Next。

5. 这时将打开“Introduction to DHCP Server”窗口。查看完信息之后，单击 Next。

6. 这时将打开“Specify the IPv4 DNS Server Settings”窗口。指定“Parent

Domain”、“Preferred DNS Server IPv4 Address”（如有需要）和“Alternate DNS

Server IPv4 Address”。然后，单击 Next。

7. 这时将打开“Specify IPv4 WINS Server Settings”窗口。提供 WINS 信息（如有
需要），然后单击 Next。

8. 这时将打开“DHCP Scopes”窗口。选择 Add，以添加新的 DHCP 作用域。这时
将打开“Add Scope”窗口，然后必须定义以下信息：

Scope Name

Starting IP Address

Ending IP Address

Subnet Mask

Default Gateway（可选）
Subnet type

定义好这些信息之后，单击 OK，然后单击 Next。

9. 这时将打开“Configure DHCPv6 Stateless Mode”窗口。单击 Enable 以启用
DHCPv6，然后配置 IPv6 DNS 设置。单击 Disable 以禁用该服务器的 DHCPv6

无状态方式。单击 Next。

10. 这时将打开“DHCP Server Selection Confirmation”窗口。查看相应信息，然后单
击 Next，开始安装。

11. 安装完成之后，单击 Close。

步骤 5（适用于 Windows Server 2003 和 Windows Server 2008）：验
证 TCP/IP 协议并设置主机或 DNS 表

您必须安装 TCP/IP 联网堆栈才能启用 SMclient 功能，所以必须执行以下两个任务：

v 确保将安装并运行 SMclient 的管理站或主机服务器上已安装 TCP/IP 协议软件。

v 设置主机或 DNS 表。

注：确保控制器的主机名与其 IP 地址匹配。
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要确保已安装了 TCP/IP 协议软件并设置主机或 DNS 表，请完成以下步骤：

1. 打开“Windows 资源管理器”窗口。

2. 右键单击“网上邻居”文件夹并选择属性。这时将打开“网络连接”窗口。

3. 右键单击一个已定义的网络连接并选择属性。

4. 在打开的 network_name 属性窗口中，选中此连接使用下列项目区域中的 Internet 协
议（TCP/IP）复选框（如果尚未选中），然后单击确定。

5. 更新 DNS 表，指定主机名与 IP 地址关联。如果没有 DNS 服务器，请使用文本编
辑器更新 hosts 文件，将 IP 地址与控制器名称条目链接在一起。以下示例显示连接
到第 14页的图 4 中网络 A 的控制器的主机表。

6. 尝试 ping c:/windows/system32/drivers/etc/hosts 文件中列出的某个控制器设备。在以
下示例中，通过在 MS-DOS 命令提示符后输入 ping denver_a 来执行此操作。

# Copyright (c) 1993-1999 Microsoft Corp.

# This is a sample HOSTS file used by Microsoft TCP/IP for Windows.

# This file contains the mappings of IP addresses to host names. Each

# entry should be kept on an individual line. The IP address should

# be placed in the first column followed by the corresponding host name.

# The IP address and the host name should be separated by at least one

# space.

# Additionally, comments (such as these) may be inserted on individual

# lines or following the machine name denoted by a '#' symbol.

# For example:

# 102.54.94.97 rhino.acme.com # source server

# 38.25.63.10 x.acme.com # x client host

127.0.0.1 localhost

192.168.128.101 denver_a

192.168.128.102 denver_b

第 2 章 准备安装 29



步骤 5（适用于 Linux）：验证 TCP/IP 协议并设置主机或 DNS 表
缺省安装过程将安装 TCP/IP 软件包。要确保成功安装了 TCP/IP 软件包，请打开 shell

提示符并输入 ifconfig。如果看见 eth0 或 eth1 界面，那么说明启用了 IP 协议。

要设置主机或 DNS 表，请完成以下步骤。确保控制器的主机名与其 IP 地址匹配。

1. 更新主机表或 DNS 表，指定主机名与 IP 地址关联。如果没有 DNS 表，请编辑
/etc/hosts 文件中的主机表。如果操作系统未安装在根目录下，那么您的目录可能有
所不同。

2. 要透过防火墙管理存储子系统，请将防火墙配置为向 TCP 数据打开端口 2463。

3. 尝试 ping /etc/hosts 文件中列出的某个控制器设备。

以下示例显示一个 Linux 主机文件。

# Do not remove the following line, or various programs
# that require network functionality will fail.

127.0.0.1 rh71_8500 localhost.localdomain
102.54.94.97 rhino.acme.com x.acme.com
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第 3 章 在标准 Windows 配置中安装 Storage Manager 软件

注：如果要配置系统用于集群，请参阅第 39页的第 4 章, 『在 Windows 集群服务器
环境中安装 Storage Manager 软件』。

本章描述如何在标准（非集群）配置中安装 Storage Manager 软件 Windows Server 版。

安装软件之前，请阅读以下信息：

v 为实现正确安装，请确保您已完成第 21页的第 2 章, 『准备安装』中描述的所有准
备任务。

v 请务必查看安装介质的相关自述文件。它包含准备本文档时尚不可用的重要信息。

v 此版本的存储管理软件不支持 64 位版本的 Windows XP。必须从 32 位管理站执行
使用存储管理软件的所有管理员功能。

v 仅在一台管理站上配置 Event Monitor，以防止收到重复的事件消息。请注意，如果
Enterprise Management 窗口与 SMmonitor 同时运行，还会发出重复警报。

v 安装过程中切勿重新启动系统。安装完所有 Storage Manager 软件组件后，重新启动
系统。

新安装过程
您可以只在主机服务器上安装 Storage Manager 软件组件，也可以既在主机服务器上安
装，又在管理站上安装。

管理站：管理站是一种用于管理存储子系统的系统。您可以通过以下任何一种方式将
它连接到存储子系统：

v 通过连接到存储子系统中控制器的 TCP/IP 以太网连接

v 通过与装有主机代理软件的主机服务器之间的 TCP/IP 网络连接，该服务器通过 I/O

通路直接连接到存储子系统

必须在管理站上安装 Storage Manager SMclient 软件。

主机服务器：主机服务器（或称主机）是通过 I/O 通路直接连接到存储子系统的服务
器。

要点：确保在安装 Storage Manager 软件之前，先安装主机总线适配器和设备驱动程序。
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要在管理站上开始安装，请参阅第 34页的『安装 Storage Manager 主机软件包』。

要在主机上开始安装，请参阅『安装 Storport miniport 主机总线适配器设备驱动程序』。

安装 Storport miniport 主机总线适配器设备驱动程序
IBM 光纤通道、iSCSI 或 SAS 主机总线适配器提供主机服务器与 DS3000 存储子系统
之间的接口。IBM 光纤通道、iSCSI 和 SAS 主机总线适配器是针对高端系统设计的高
性能、直接存储器存取以及总线主控器的主机适配器。光纤通道主机总线适配器支持
所有支持专用环路、直接连接和光纤网环路连接的光纤通道外围设备。IBM 主机总线适
配器设备驱动程序使操作系统能与主机总线适配器进行通信。

Storage Manager 软件为基于 Microsoft Storport miniport 设备驱动程序模型的光纤通道、
iSCSI 或 SAS 主机总线适配器设备驱动程序提供多路径支持。Microsoft Windows Server

2003 发行版采用了 Storport miniport 设备驱动程序模型，用它取代 SCSIport miniport

设备驱动程序模型。它是支持 AMD64 和 EM64T 服务器的 Windows Server 2003 x64

版唯一支持的设备驱动程序模型。

要支持 Storport Miniport 设备驱动程序，Windows Server 2003 操作系统中就必须安装
S e r v i c e P a c k 2 和 S t o r p o r t M i n i p o r t 最新修订程序。您可以从 h t t p : / /

www.support.microsoft.com/kb/932755/en-us/ 下载 Storport 最新修订程序。要了解控制器
固件版本或其他 Microsoft 更新等其他要求以及最新版本修订程序的相关信息，请参阅
针对 Microsoft Windows 操作系统的 Storage Manager 自述文件。

Storage Manager 软件 Windows Server 2003 版和 Windows Server
2008 版

适用于 Microsoft Windows Server 2003 和 Windows Server 2008 的 Storage Manager

软件包由以下组件构成：

v Storage Manager Agent（SMagent）

v Storage Manager Utility（SMutil）

v Storage Manager Client（SMclient）

v Storage Manager 冗余磁盘阵列控制器（RDAC）

注：Storage Manager RDAC 将安装 Windows 版多路径 I/O（MPIO）设备特定模块
（DSM）多路径驱动程序。Storage Manager RDAC 不同于 Linux 多路代理
（MPP）多路驱动程序。

将 Storage Manager Client（SMclient）安装在管理站上。可以选择将 SMclient 安装在
主机管理站上。

仅在主机上安装以下组件：

v Storage Manager RDAC（MPIO）

v Storage Manager Agent（SMagent）

v Storage Manager Utility（SMutil）
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Storage Manager Client
Storage Manager Client（SMclient）组件提供用于管理存储子系统的图形用户界面
（GUI）。SMclient 包含两个主要组件：

v Enterprise Management。使用 Enterprise Management 组件可在管理域中添加、除
去并监控存储子系统。

v Subsystem Management。使用 Subsystem Management 组件可管理各个存储子系
统的组件。

Event Monitor 是与 SMclient 捆绑提供的独立程序。如果安装 Event Monitor，它会在
Enterprise Management 窗口处于关闭状态时监控存储子系统。它在后台持续运行并在出
现严重问题时发出警报通知。

注：如果要使用 ESM 固件自动同步功能，您必须启用 Event Monitor。

当您将新的 ESM 安装到现有 EXP3000 中，而 EXP3000 又连接到支持 ESM 固件自
动同步的 DS3000 存储子系统时，此功能可通过实现新 ESM 中与现有 ESM 中固件的
自动同步来解决固件不匹配的问题。

注：仅当 .esm 文件位于 c:\program files\ibm_ds3000\client\data\firmware\esm\ 目录中时，
Event Monitor 才能执行 ESM 固件同步功能。每次从 Storage Manager 软件执行
新的 ESM 固件下载时，.esm 文件都将自动添加到此目录。

Storage Manager RDAC（MPIO）
Storage Manager RDAC（MPIO）包含多路径驱动程序，当主机 I/O 通路上的组件发生
故障时，需要使用该驱动程序支持控制器故障转移。

Storage Manager Agent
Storage Manager Agent（SMagent）提供一种管理渠道，使 SMclient 能通过 I/O 通路
配置并监控 DS3300 和 DS3400 存储子系统。该代理还根据 SMclient 是安装在主机上
还是通过 TCP/IP 网络安装在网络管理站上，提供对 SMclient 的本地或远程访问。

注：本文档发布时，DS3200 尚不支持频带内管理。

Storage Manager Utility
Storage Manager Utility 套件可用于检测新映射逻辑驱动器并列出当前主机的映射逻辑
驱动器。该软件包含有以下组件：

v hot_add 实用程序

hot_add 实用程序用于向操作系统注册新建的逻辑驱动器。要获取更多信息，请参阅
联机帮助。
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v SMdevices 实用程序

SMdevices 实用程序用于将存储子系统逻辑驱动器与操作系统设备名进行关联。要了
解更多信息，请参阅第 98页的『使用 SMdevices 实用程序』。

v SMrepassist 实用程序

SMrepassist 实用程序用于在创建 FlashCopy 或 VolumeCopy 映像之前清空已高速缓
存的数据。有关更多信息，请参阅第 99页的『使用 SMrepassist 实用程序』。

注：SMrepassist 实用程序仅适用于 Windows。如果您使用的是非 Windows 操作系
统，请卸装该文件系统。

安装 Storage Manager 主机软件包
本部分描述如何在运行 Windows 操作系统的管理站和主机服务器上安装 Storage Man-

ager 主机软件的不同组件。

安装软件之前，请确保管理站或主机服务器至少可提供 220 MB 可用磁盘空间，用于放
置安装软件包、安装过程中的临时文件以及安装后的最终文件。

要点：当您在独立主机上安装 SMclient 并通过 I/O 通路而不是网络来管理存储子系统
时，您必须在主机上安装 TCP/IP 软件并为主机指定 IP 地址。

Storage Manager 主机软件的全部四个组件，即 SMclient、Storage Manager

RDAC（MPIO）、SMagent 和 SMutil 都包含在一个主机软件包安装程序中。通过使用
该主机软件包安装程序最多可安装四个软件包。

注：Microsoft Windows XP 和 Windows Vista 操作系统仅支持 Storage Manager Cli-

ent 软件包。请勿在 Windows XP 和 Windows Vista 上安装任何其他 Storage Man-

ager 软件包。Windows XP 或 Windows Vista 不支持 MPIO。

要在主机服务器或管理站上安装 Storage Manager 主机软件包，请完成以下步骤。

要点：这些安装说明不适用于具有 SAN 引导或远程引导磁盘的主机服务器。只有
DS3300 和 DS3400 存储子系统支持 SAN 引导或远程引导磁盘。

1. 安装本软件之前，请关闭所有其他程序。

2. 将 IBM System Storage DS3000 支持 CD 插入 CD 驱动器中。

注：如果已经从 DS3000 支持 Web 站点下载了 Storage Manager 主机软件包 Win-

dows 版，您必须将 downloaded .zip 文件解压缩到特定目录中。转至该目录并
选择 Windows 目录，即可找到 Windows 主机软件包安装程序。转至步骤 第
35页的 6。

3. 从 Windows 桌面双击我的电脑图标。这时将打开“我的电脑”窗口。

4. 双击包含 Support CD 的 CD 驱动器。这时将打开“CD”窗口。
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5. 选择 CD 中与您的操作系统体系结构对应的目录。

目录 操作系统

Windows_x86_32bit W i n d o w s S e r v e r 2 0 0 3 x 8 6 3 2 位版
（IA32）Server、Enterprise Edit ion 和
DataCenter

W i n d o w s S e r v e r 2 0 0 8 x 8 6 3 2 位版
（IA32）Server、Enterprise Edit ion 和
DataCenter

Windows_x64_64bit Windows Server 2003 x64 64 位版（AMD64

和 EM64T）Server、Enterprise Edition 以及
DataCenter

Windows Server 2008 x64 64 位版（AMD64

和 EM64T）Server、Enterprise Edition 以及
DataCenter

6. 要启动主机软件包安装程序，请双击可执行文件（.exe），如 SMIA-WSxxx.exe。

装入软件时会打开 InstallAnywhere 安装向导窗口。按照每个向导窗口中的指示信息
操作。

7. 打开 Select Installation Type 窗口时，您可以选择以下某个选项（请参阅第 36页的
图 7）：

v Typical (Full Installation)：此缺省选项在系统上安装所有软件包。如果您不清
楚应该选择哪种安装类型，可以选择此选项。此选项安装全部四个主机软件组
件：SMclient、MPIO、SMagent 和 SMutil。这是运行支持服务器操作系统（例如
Microsoft Windows Server、SUSE Linux Enterprise Server 或 Red Hat Enter-

prise Linux）的主机的缺省选择。

v Management Station：此选项安装配置、管理和监控存储子系统所需的软件。
它适用于工作站或管理计算机。此选项只安装 SMclient 程序。这是运行支持客
户机操作系统（例如 Microsoft Windows XP 或 Windows Vista）的主机的缺省
选择。

v Host：此选项安装存储子系统服务器软件。这一安装类型适用于连接到存储子
系统的主机（服务器）（仅适用于 Windows Server 2003 和 Windows Server

2008）。它安装除 SMclient 程序以外的所有主机软件组件。

v Custom：此选项允许您定制要安装的功能部件。

要点：首先必须安装 MPIO 软件包，随后才能安装和使用 Storage Manager

Agent。
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8. 单击 Next。

如果存在先前安装的 Storage Manager 软件包，将打开 Overwrite Warning 窗口。

9. 如果出现 Overwrite Warning 窗口，请单击 OK。

这时将打开 Automatically Start Monitor 窗口。这是 Event Monitor 服务，它将监
控指定的 DS3000 存储子系统并在 SMclient 程序不运行时转发这些子系统的关键
警报。

10. 在 Automatically Start Monitor 窗口中，选择系统的对应选项。

注：

a. 要启用 ESM 固件自动同步，必须启用 Event Monitor。请选中 Automati-
cally Start Monitor。要获取更多信息，请参阅第 85页的『ESM 固件自动同
步』。

b. 如果在多个系统上启动 Event Monitor 服务，您可能会收到同一存储阵列发出的
重复错误消息。要防止收到重复的错误消息，请仅在一个将持续运行的系统上
启动 Event Monitor。

11. 单击 Next。

这时将打开 Pre-Installation Summary 窗口。

12. 单击 Install。

图 7. Select Installation Type 窗口
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安装软件时将打开 Installing IBM DS3000 Storage Manager 窗口。安装过程中可
能还会打开 Installation/Remove 状态窗口。软件安装完毕后，会打开 Install Com-

plete 窗口。

要点：

如果在安装完成前（仍可以看到进度条时）取消安装，安装程序可能无法正确清
除已取消的安装，并且主机软件安装向导会创建一个安装日志。另外“添加或删
除程序”窗口可能会显示该程序已安装。但当您尝试卸载它时，会显示卸载错误
并询问您是否要从添加/删除程序列表中除去该条目。单击是除去该条目。然后，
您必须从以下某个目录中删除 .xml 文件：

v 对于 Windows Server 2003 32 位版或 Windows Server 2008 32 位版：
Windows_boot_drive_letter:\Program Files\Zero G Registry

v Windows Server 2003 64 位版：
Windows_boot_drive_letter:\Program Files (x86)\Zero G Registry

普通 Windows 资源管理器视图可能会隐藏 Windows_boot_drive_letter:\Program Files\

Zero G Registry 目录。如果是这样，请将 Windows 资源管理器的设置改为显示隐
藏文件和文件夹。

如果您在显示进度条之前取消安装，安装向导可正确清除已取消的过程。再次启
动向导之前，您不需要执行任何操作。

13. 确保已选中 Yes, restart my system 选项。

14. 单击 Done。

多个文件和程序包将安装到您之前指定的目录中。缺省目录如下：

v 对于 Windows Server 2003 32 位版或 Windows Server 2008 32 位版：
Windows_boot_drive_letter:\Program Files\IBM_DS3000

v Windows Server 2003 64 位版：
Windows_boot_drive_letter:\Program Files (x86)\IBM_DS3000

安装完成，重新启动 Windows。

要点：如果在完成安装过程之前反复取消安装或卸载，并尝试再次安装本软件，
安装过程可能无法正常进行，并且安装过程完成后可能未安装软件。“安装完
成”窗口显示的是软件安装位置，但是找不到该软件。如果出现此问题，请从第
36页的 12 中列出的相应缺省目录中删除 .xml 文件。

要确保软件包已安装，请转至第 38页的『验证安装』。
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验证安装
要确保主机软件包安装程序已成功运行，请完成以下步骤：

1. 选择开始 → 设置 → 控制面板。

这时将打开“控制面板”窗口。选择添加或删除程序。这时将打开“添加或删除程
序”窗口。

2. 找到 IBM DS3000 Storage Manager Host Software 条目。该条目包含相应的版本号，
如 02.17.x5.00。

3. 如果安装成功（未报告失败），请转至第 65页的第 8 章, 『完成 Storage Manager

软件的安装和配置』。否则，请重复第 34页的『安装 Storage Manager 主机软件包』
中的步骤。如果仍然失败，请与您的技术支持代表联系。

要获取有关在 Windows 中卸载 Storage Manager 软件组件的信息，请参阅第 100页的
『卸载存储管理软件组件』。

配置存储管理
安装 Storage Manager 软件后，请完成第 65页的第 8 章, 『完成 Storage Manager 软
件的安装和配置』中描述的以下任务。

v 执行首次存储子系统自动发现

v 添加存储子系统

v 命名存储子系统

v 配置警报

v 配置主机访问权

v 定义主机组

v 创建阵列和逻辑驱动器

v 管理 iSCSI 设置（仅适用于 DS3300）

v 下载控制器固件和 NVSRAM
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第 4 章 在 Windows 集群服务器环境中安装 Storage Manager
软件

本章描述如何在 Windows 集群服务器环境中安装 Storage Manager 软件。安装软件之
前，请完成第 21页的第 2 章, 『准备安装』中描述的所有准备任务。

要点：安装软件之前，请务必查看针对您的操作系统的 Storage Manager 软件自述文件。
它包含准备本文档时尚不可用的重要信息。

预安装注意事项
硬件安装包括安装主机总线适配器和存储子系统。开始安装 DS3000 Storage Manager 软
件之前，请确保已经为集群服务器配置正确安装了所有硬件组件。

配置选项
您可以将存储子系统直接连接到集群节点，也可以通过交换机将它连接到集群节点
（仅适用于 iSCSI 和光纤通道主机总线适配器）。第 40页的图 8 显示典型直接连接或光
纤通道交换机连接配置。两种配置都提供完全冗余。
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主机总线适配器
要了解特定主机总线适配器的安装要求和过程，请参阅主机总线适配器随附的文档。
请考虑以下注意事项：

v 要使用双路径配置，请执行以下任务：

– 在每个节点中安装两个主机适配器。

– （仅光纤通道主机总线适配器）将两根光缆从各个节点连接到存储子系统。

图 8. 在光纤通道、iSCSI 或 SAS 网络中安装存储子系统
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v 如果通过光纤通道仲裁环路（FC-AL）连接存储子系统，请确保为环路中的每个适
配器指定唯一的硬标识。要获取更改硬标识的指示信息，请参阅主机总线适配器随
附的文档。

v 确保为主机适配器安装了正确的设备驱动程序。要获取受支持的主机适配器和设备
驱动程序的信息，请参阅 IBM System Storage DS3000 支持 CD 中 \HostAdapter 目
录下的自述文件。

存储子系统
要了解特定硬件的安装要求和过程，请参阅硬件随附的文档。如果直接管理存储子系
统，必须将以太网电缆连接到每个存储子系统的两个控制器。

安装 Storport miniport 主机总线适配器设备驱动程序
IBM 光纤通道、iSCSI 或 SAS 主机总线适配器提供主机服务器与 DS3000 存储子系统
之间的接口。IBM 光纤通道、iSCSI 和 SAS 主机总线适配器是针对高端系统设计的高
性能、直接存储器存取以及总线主控器的主机适配器。光纤通道主机总线适配器支持
所有支持专用环路、直接连接和光纤网环路连接的光纤通道外围设备。IBM 主机总线适
配器设备驱动程序使操作系统能与主机总线适配器进行通信。

Storage Manager 软件支持基于 Microsoft Storport Miniport 设备驱动程序模型的光纤通
道、iSCSI 或 SAS 主机总线适配器设备驱动程序。Microsoft Windows Server 2003 发
行版采用了 Storport miniport 设备驱动程序模型，用它取代 SCSIport miniport 设备驱
动程序模型。它是支持 AMD64 和 EM64T 服务器的 Windows Server 2003 x64 版唯
一支持的设备驱动程序模型。

要支持 Storport Miniport 设备驱动程序，Windows Server 2003 操作系统中就必须安装
S e r v i c e P a c k 2 和 S t o r p o r t M i n i p o r t 最新修订程序。您可以从 h t t p : / /

www.support.microsoft.com/kb/932755/en-us/ 下载 Storport 最新修订程序。要了解控制器
固件版本或其他 Microsoft 更新等其他要求以及最新版本修订程序的相关信息，请参阅
针对 Microsoft Windows 操作系统的 Storage Manager 自述文件。

在 Windows Server 2003 或 Windows Server 2008 集群环境中安装
Storage Manager 软件

要在 Windows Server 2003 或 Windows Server 2008 上安装 Storage Manager 软件和
集群服务软件，请完成以下步骤：

1. 确保已在每个集群节点中安装了主机总线适配器和设备驱动程序。要获取安装主
机总线适配器和设备驱动程序的信息，请参阅『安装 Storport miniport 主机总线适
配器设备驱动程序』。

2. 在将作为集群第一个节点的主机服务器上安装 Storage Manager 软件。要获取安装
指示信息，请参阅第 34页的『安装 Storage Manager 主机软件包』。

注：在现有存储子系统上安装 Storage Manager 软件之前，请参阅您的硬件文档以
获取特定配置的指示信息。您可能需要特定的配置，以使集群配置中的硬件
支持 Storage Manager 软件。

3. 完成第 65页的第 8 章, 『完成 Storage Manager 软件的安装和配置』中的过程，
特别是创建将用作集群磁盘的 LUN 并确保这些 LUN 映射到的主机组或主机端口
的主机类型已设置为 Windows 2000/Server 2003 Clustered 。

第 4 章 在 Windows 集群服务器环境中安装 Storage Manager 软件 41

http://www.support.microsoft.com/kb/916048/en-us/
http://www.support.microsoft.com/kb/916048/en-us/


注：要看到新添加的逻辑驱动器（LUN），您可能必须重新启动集群的第一个节
点。

4. 在集群的第二个节点上安装 Storage Manager 软件。

注：必须安装 MPIO 和 SMutil 软件包。除非要从这个集群节点管理存储子系统，
否则您不必安装所有 Storage Manager 软件包。

为集群的每个其他节点重复步骤 4。

5. 将所有共享逻辑驱动器格式化为新技术文件系统（NTFS）、指定卷标并为它们各
自指定一个盘符。

要点：您必须确保指定到第一个集群节点中的 LUN 的永久（粘性）盘符在其余集
群节点中可用（未使用）。集群中的所有节点在每个共享驱动器上必须具有
相同的盘符。如果您不指定永久盘符，Windows 可能会在每个节点上指定不
同的盘符，从而妨碍集群磁盘正确运转。为确保 Windows 在所有集群节点
上为分区指定相同的盘符，请指定一个永久盘符。

6. 在集群的第一个节点上安装集群服务器软件。要了解安装集群服务器软件的正确
过程，请参阅相应的 Microsoft Cluster Server（MSCS）文档。

要点：在 Microsoft 集群解决方案的安装过程中，您必须对集群的任何其他节点执行以
下步骤：

a. 启动 Cluster Administrator。

b. 在 Cluster Administrator 中单击 Join an existing cluster。

c. 输入用作节点 1 上集群的集群名。

d. 与集群建立连接后，单击 Select Computer 页面上的 Advanced。

e. 单击 Advanced (minimum) configuration。

7. 在集群的第二个节点上安装集群服务器软件。要了解在集群服务器上安装其他节
点的正确过程，请参阅相应的 MSCS 文档。

注：在安装过程中，指定您要加入现有集群。您可以一次添加一个集群节点，也
可以一次添加所有剩余的集群节点。应一次添加一个集群节点。

8. 如果 Cluster Administrator 窗口左侧未显示所有节点名，请重新安装集群服务器软
件。如果问题仍然存在，请与您的技术支持代表联系。

9. 在 Cluster Administrator 窗口中，确保所有集群磁盘组可以正常联机、脱机。

10. 将集群磁盘组从第一个集群节点手动移至集群中的各个节点，确保它们可以联
机。如果它们可以正常联机，您就可以继续安装应用程序软件。如果遇到任何问
题，请致电您的技术支持代表。

配置存储管理
安装 Storage Manager 软件后，请完成第 65页的第 8 章, 『完成 Storage Manager 软
件的安装和配置』中描述的以下任务。

v 执行首次存储子系统自动发现

v 添加存储子系统

v 命名存储子系统

v 配置警报
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v 配置主机访问权

v 定义主机组

v 创建阵列和逻辑驱动器

v 管理 iSCSI 设置（仅适用于 DS3300）

v 下载控制器固件和 NVSRAM
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第 5 章 在 Linux 配置中安装 Storage Manager 软件

本章描述如何在 Linux 操作系统环境中安装 Storage Manager 软件。

注：本文档不提供在基于 POWER 的主机上使用 Linux 的相关信息。

安装概述
安装 Storage Manager 软件之前，请阅读以下信息：

v 安装软件之前，请阅读针对您的操作系统的 Storage Manager 软件自述文件。它包含
准备本文档时尚不可用的重要信息。

v 确保您已完成第 21页的第 2 章, 『准备安装』中描述的所有准备任务。

v 确保网络组件已正确安装并且运行正常。

v 确保您已获得运行软件所需的主机和控制器信息。

在每台主机服务器上按以下顺序安装软件：

1. 安装针对 Linux 操作系统的 IBM 主机总线适配器设备驱动程序。

2. 安装 Linux MPP。

3. 根据您所需的系统类型安装 Storage Manager 2 软件。

注：对于 Storage Manager 2，主机软件包的缺省安装目录是 /opt/IBM_DS3000。

安装 IBM 主机总线适配器设备驱动程序
IBM 主机总线适配器为主机服务器与 DS3000 存储子系统之间提供接口。IBM DS3000

主机总线适配器是针对高端系统设计的高性能、直接存储器存取、总线主控器主机适
配器。光纤通道主机总线适配器支持所有支持专用环路、直接连接和光纤网环路连接
的光纤通道外围设备。IBM 主机总线适配器设备驱动程序使操作系统能与主机总线适配
器进行通信。

在安装 Storage Manager 软件之前，安装主机总线适配器设备驱动程序。要获取操作系
统的安装指示信息，请参阅设备驱动程序软件包随附的自述文件。要获取更多信息，
请参阅主机总线适配器随附的 Installation and User’s Guide。

可以从 http://www.ibm.com/servers/storage/support/disk/ 下载最新的自述文件和 IBM 主
机总线适配器设备驱动程序。

Storage Manager 软件 Linux 版
可从 Support CD 和 http://www.ibm.com/servers/storage/support/ 获取用于 Linux 操作
系统的两个内核版本的 DS3000 Storage Manager 软件包。这些软件包仅适用于基于 Intel

及 AMD 架构 x86 32 位（IA-32）和 x86 64 位（AMD64 和 EM64T）处理器的服务
器。

适用于 Linux 的 Storage Manager 软件包由以下组件构成：

v Storage Manager Runtime（SMruntime）

v Storage Manager Utility（SMutil）
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v Storage Manager Client（SMclient）

v Linux MPP

注：Linux MPP 以软件包的形式与用于 Linux 的 Storage Manager 软件包分别提供。
Linux MPP 安装用于 Linux 的多路径代理（MPP）多路径驱动程序。Linux MPP

不同于用于 Windows 的 Storage Manager RDAC。

将 Storage Manager Client（SMclient）组件安装在管理站上。可以选择将 SMclient 安
装在主机服务器上。

仅在主机上安装以下组件：

v Storage Manager Utility（SMutil）

v Linux MPP

v Storage Manager Agent（SMagent）

管理站组件
将以下组件安装在管理站上。可以选择将这些组件安装在主机服务器上。

v Storage Manager Runtime（SMruntime）

此组件随 Storage Manager Client 自动安装。它包含运行其他软件包所需的 Java™ 运
行时环境。

v Storage Manager Client（SMclient）

如果要从主机服务器或管理站管理存储子系统，就需要此组件。

主机组件
仅在主机上安装以下组件：

v Storage Manager Utility（SMutil）

此组件随附在 SMclient 软件包中，它包含 hot_add 和 SMdevices 实用程序。

v Linux MPP

此组件提供多路径故障转移/故障恢复功能。

注：Linux MPP 不和其他软件组件一起包含在 Linux 操作系统的 Storage Manager 软
件包中。并且每个 Linux 内核版本对应一个不同版本的 RDAC，所以请查看最
新的自述文件以确保您使用的版本与 Linux 内核正确对应。

v Storage Manager Agent（SMagent）

如果要对 DS3300 和 DS3400 存储子系统使用主机代理（频带内）管理方法，就需
要此组件。安装 SMagent 之前必须安装 Linux MPP。

注：

1. 在 Linux 操作系统环境中，DS3000 存储子系统的首选管理方法是直接（频带外）
方法。

2. 本文档发布时，DS3200 尚不支持频带内管理。
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使用安装向导安装 Storage Manager 2 软件
DS3000 Storage Manager 安装向导是一种基于 Java 的交互式方法，您可以通过它选择
要自动安装到主机系统的软件包。安装向导在 Linux 主机上安装以下软件包：

v SMclient

v SMagent

v SMutil

注：安装 Storage Manager 软件之前，请确保 Linux 主机上已安装图形适配器。

要使用安装向导安装 Storage Manager 软件，请完成以下步骤：

1. 确保您拥有安装软件所需的 root 权限。

2. 将 IBM System Storage DS3000 支持 CD 插入 CD 驱动器，如果必要，请安装 CD

驱动器。

3. 将 SMIA-LINUXxxx 主机软件安装包从 CD 复制到某个系统目录中。

注：可以从 http://www.ibm.com/servers/storage/support/ 下载最新版本的 Storage Man-

ager 主机软件包。

4. 转至您复制 SMIA-LINUXxxx 软件包的目录，使用以下格式输入 SMIA-LINUXxxx

文件的文件名启动 Storage Manager 安装向导：

./SMIA-LINUXxxx-02.17.xx.xx.bin

这时将打开 Storage Manager 安装向导 Introduction 窗口。

5. 按照每个向导窗口中的指示信息操作。选择安装类型时，您可以选择以下某个选项
（请参阅第 48页的图 9）：

v Typical (Full Installation)：安装所有 Storage Manager 软件包

v Management Station：安装 SMruntime 和 SMclient

v Host：安装 SMruntime、SMagent 和 SMutil

v Custom：允许您选择要安装的软件包
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注：缺省情况下，Storage Manager 软件包安装在 /opt/IBM_DS3000 目录中。

Linux MPP 软件包
仅当系统是主机时，才需要安装 RDAC 软件包。您必须在每台主机服务器上安装
RDAC。RDAC 软件包将安装支持控制器故障转移所需的多路径设备驱动程序。安装
RDAC 设备驱动程序软件包时，需要重新启动系统。

注：

1. 必须在安装 RDAC 之前安装主机总线适配器设备驱动程序。要了解主机总线适配器
设备驱动程序的受支持级别，请参阅 Storage Manager 2 自述文件。

2. Linux MPP 与 Storage Manager 2 主机软件包分别提供。Linux MPP 软件包有两个，
分别用于不同类型的内核：

v 2.6 内核（RHEL 4、SLES 9 和 SLES 10）（适用于 RDAC 修订版 B）

v 2.6 内核（RHEL 5 和 SLES 10 SP1）（适用于 RDAC 修订版 C）

请确保为系统安装正确的 Linux MPP。

要点：这两个 Linux MPP 软件包都不能用于基于 POWER 的服务器上的 Linux。

3. 要获取安装 Linux MPP 的最新说明，包含任何依赖性或局限性，请查看 Linux MPP

软件包随附的自述文件。

4. 此 Linux MPP 版本不支持自动卷转移/自动磁盘转移（AVT/ADT）方式。缺省情况
下将禁用 AVT/ADT，从而使 Linux MPP 可以正常运行。

图 9. Select Installation Type 窗口
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要从放置 RDAC 源 .tgz 文件的目录中解压缩 Linux MPP 源文件，请在命令提示符中
输入以下命令并按 Enter 键：

tar -zxvf filename.tar.gz

其中 filename 是 Linux MPP 源文件的名称。

源文件将解压缩到 yourdirectory/linuxrdac-version 目录中（其中 version 是 RDAC 号，
如 linuxrdac-09.01.B5.39）。

要了解编译和安装设备驱动程序模块的详细过程，请参阅『安装 Linux MPP』。

安装 Linux MPP
Linux MPP 为 DS3000 存储子系统中映射到 Linux 主机服务器的逻辑驱动器提供多路
径故障转移/故障恢复支持。对于双控制器配置，Linux 主机服务器与 DS3000 存储子系
统的控制器 A 和 B 的主机端口必须建立 I/O 连接（取决于主机总线适配器类型）。

要了解最新的相关依赖性，请参阅 Storage Manager 自述文件。您可以在 Support CD

和 http://www.ibm.com/servers/storage/support/disk/ 上找到该文件。

要了解最新的受支持 DS3000 存储子系统型号、主机总线适配器、设备驱动程序、Linux

内核版本以及最新的自述文件，请访问 http://www.ibm.com/servers/storage/support/

disk/。

注：不支持所列代码级别以外的级别。要获取更多信息，请与您的技术支持代表联
系。

局限性
v Linux SCSI 层不支持跳过的（稀疏）LUN。如果映射的 LUN 不是相连的，Linux 内
核不会扫描剩余的 LUN。因此，主机服务器无法使用跳过的 LUN 之后的 LUN。请
务必使用连续的 LUN 编号映射 LUN。

v 如果具有光纤通道主机总线适配器的主机服务器具有多个主机总线适配器端口，并
且每个端口都可以通过未分区的交换机看到两个控制器，那么 Linux MPP 驱动程序
在控制器故障转移过程中可能会返回 I/O 错误。在这种情况下，可使用多个未连接的
光纤通道交换机将光纤通道交换机划分为多个区，使每个主机总线适配器端口只能
看到 DS3000 存储子系统中的一个控制器。

v 如果未连接存储子系统，那么无法装入虚拟主机总线适配器设备驱动程序。这种情
况的变通方法是将主机服务器连接到 DS3000 存储子系统，然后运行 hot_add 实用程
序。

注：如果没有 LUN 映射到 DS3000 存储子系统上的主机服务器分区，hot_add 实用
程序不会启用 mpp_Vhba 模块。

v Linux MPP 驱动程序不支持删除 LUN。删除映射的逻辑驱动器后，您必须重新启动
服务器。

v 请勿使用 modprobe 内核模块实用程序装入或卸装 RDAC 驱动程序堆栈，该堆栈包
含 mpp_Upper 和 mpp_Vhba 工具以及低级主机总线适配器设备驱动程序。用户对
RDAC 驱动程序堆栈使用 modprobe 必须自行承担后果。IBM 不支持对 RDAC 驱
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动程序堆栈使用 modprobe。也不支持使用 rmmod 依次除去 RDAC 驱动程序堆栈中
的所有驱动程序。如果必须卸装驱动程序堆栈，请重新启动系统。

先决条件
v Linux MPP 驱动程序以源代码软件包的形式发布，采用 gunzip 压缩 tar 文件格式。
要解压缩驱动程序源代码软件包，请在 Linux 控制台窗口中输入以下命令：tar -zxvf

rdac-LINUX-xx.xx.xx.xx-source.tar.gz，其中 xx.xx.xx.xx 是 RDAC 驱动程序的发
行版本。源文件将解压缩到 linuxrdac-version 目录中（其中 version 是 RDAC 号，
如 linuxrdac-09.01.B5.39）。

v 安装 Linux MPP 驱动程序之前，请在主机服务器上构建并安装主机总线适配器设备
驱动程序。要获取安装设备驱动程序的指示信息，请参阅主机总线适配器设备驱动
程序自述文件或主机总线适配器 Installation and User's Guide。如果需要从源代码树
构建主机总线适配器设备驱动程序，可以在源代码软件包中找到设备驱动程序源代
码树。必须在 RDAC 安装之前装入该设备驱动程序。

v 主机服务器可能配备多个供应商提供的不同主机总线适配器，或同一供应商提供的
不同型号的主机总线适配器；但是，只有一个型号的主机总线适配器可以连接到
DS3000 存储子系统。

v 确保在安装 RDAC 驱动程序软件包之前，您已安装用于构建 Linux 内核版本的内核
源代码树。

仅适用于 SUSE Linux 企业服务器 9 分发版
要为 SUSE Linux 企业服务器 9 环境安装并设置 Linux MPP，请完成以下步骤：

1. 安装 SUSE 分发版的内核源代码。

2. 输入以下命令，创建一个指向内核源代码的软链接：

ln -sf /usr/src/linux-version /usr/src/linux

3. 为确保设备驱动程序与所运行内核之间的内核版本保持同步，请在 Linux 控制台窗
口中输入以下命令。输入每条命令后按 Enter 键：

v cd /usr/src/linux

v make mrproper（彻底清除内核树）

v - cp /boot/config-`uname -r` .config（复制新的配置文件）

v make oldconfig（使用 .config 文件更新配置）

v make dep（重新构建依赖性）

v make modules（构建模块，较新的内核版本不需要该操作）

为 SUSE Linux 和 Red Hat Linux 构建 RDAC 驱动程序
1. 转至 linuxrdac 目录。

2. 要除去该目录中原有的驱动程序模块，请输入以下命令并按 Enter 键：

make clean

3. 要在带多个处理器（SMP 内核）的服务器中编译所有驱动程序模块和实用程序，请
输入以下命令并按 Enter 键：

make
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安装 RDAC 驱动程序
1. 要将驱动程序模块复制到内核模块树并构建新的 RAMdisk 映像（mpp.img），该映
像包含 RDAC 驱动程序模块和引导时间所需的所有驱动程序模块，请输入 make

install 并按 Enter 键。

2. 按照构建过程最后显示的指示信息操作以添加新的引导菜单选项，它使用 /boot/mpp-

kernel version.img 作为初始 RAMdisk 映像。

3. 在 Linux MPP 安装快结束时，如果出现错误消息 All of your loopback devices

are in use、未创建 RDAC RAMdisk 并且安装失败，请在 Linux 控制台窗口中输
入以下命令：

insmod loop（此命令将回送设备驱动程序装入内核。）

make uninstall（此命令卸载先前未成功的 RDAC 驱动程序。）

make install（此命令再次安装 RDAC 驱动程序。）

对于某些 Red Hat 内核版本，以下指示信息可能适用。将 ramdisk_size=15000 作为
内核引导参数添加到新的引导选项中，类似于以下 grub.conf 示例。

注：根据系统设置配置，实际文本可能有所不同。

title Red Hat Linux Advanced Server-up (2.4.9-e.27smp)
root (hd0,6)
kernel /vmlinuz-2.4.9-e.27smp ro root=/dev/hda7 ramdisk_size=15000
initrd /mpp-<kernel version>.img

RDAC 驱动程序安装后
1. 使用 New Boot Menu 选项重新启动系统。

2. 输入 lsmod，确保驱动程序堆栈已正确安装。

注：对于 R e d H a t 分发版，应安装以下模块：
scsi_mod、sd_mod、sg、mpp_Upper、mpp_Vhba(*) 以及主机总线适配器设备驱
动程序。对于 S U S E L i n u x 分发版，应安装以下模块：
sg、mpp_Upper、mpp_Vhba(*) 以及主机总线适配器设备驱动程序。

3. 要确保 RDAC 驱动程序已发现可用物理 LUN 并已为它们创建虚拟 LUN，请输入
ls -lR /proc/mpp 并按 Enter 键。

现在可以向 LUN 发出 I/O。

4. 如果您对 MPP 配置文件（/etc/mpp.conf）或 /var/mpp/devicemapping 持久绑定文件
作出任何更改，请运行 mppUpdate 重建 RAMdisk 映像并包含新文件，以便下次重
新启动系统时可以使用新的配置文件（或持久绑定文件）。

要捕获 MPP 驱动程序的所有调试和错误消息， /etc/syslog.conf 文件必须包含
kern.debug、kern.notice、kern.info 和 kern.warning 的相应条目。

Proc 条目
要确保 RDAC 驱动程序已发现可用物理 LUN 并已为它们创建虚拟 LUN，请输入 ls

-lR /proc/mpp 并按 Enter 键。
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Linux 操作系统提供一个 /proc 文件系统，它是一种特殊的仅限内存使用、软件创建的
文件系统，内核使用它向用户空间导出设备驱动程序信息。

proc 伪文件系统安装到 /proc。Linux SCSI 子系统 proc 文件系统目录是 /proc/scsi。按
照惯例，每个主机总线适配器设备驱动程序在 /proc/scsi 下创建一个子目录。

Linux MPP 驱动程序 proc 条目如下：

v /proc/mpp

MPP 驱动程序的条目。

v /proc/scsi/mpp/adapter_number

MPP 虚拟主机适配器的条目。它因系统不同而异，并由 SCSI 中间层指定。

v /proc/mpp/storage_sys_name

主机可看到的每个子系统的条目。

v /proc/mpp/storage_sys_name/controllerA/B

每个子系统中主机看到的两个目标的条目。每个存储子系统有两个控制器。

v /proc/mpp/storage_sys_name/controllerA/B/low_level_driver/HCT#

low_level_driver 可以是 QLogic、Emulex、LSI Logic 主机总线适配器或 iSCSI 软件
发起方中的任何一个。HCT# 可以是 Host#（SCSI 中间层所指定低级驱动程序的主机
编号）、Channel#（取决于主机总线适配器为单端口还是双端口）或 Target#（低级主
机总线适配器设备驱动程序为这个子系统上的该控制器指定的目标编号）。

v /proc/mpp/storage_sys_name/controllerA/B/low_level_driver

存储子系统的主机分区上映射的或通过该路径看到的逻辑驱动器或逻辑驱动器的 LUN

数，或者是启动程序（主机）目标组合。

持久命名
主机系统重新启动时，Linux SCSI 设备名可能改变。首选方法是使用 devlabel 等实用
程序创建用户定义的设备名，这些名称将根据称为 UUID 的唯一标识来映射设备。

卸载和重新安装（更新）RDAC 驱动程序包
要卸载 RDAC 驱动程序软件包，请输入 make uninstall 并按 Enter 键。

注：要重新安装或更新 RDAC 驱动程序软件包，请输入 make uninstall，然后在新
RDAC 驱动程序源代码束中的 /linuxrdac 目录下输入 make install。

内核更新
要在应用内核更新并引导进入新的内核后为新内核构建 MPP Initrd 映像，请完成以下
步骤：

1. 转至 Linuxrdac 源代码目录。

2. 输入命令 make uninstall。

3. 按照第 50页的『为 SUSE Linux 和 Red Hat Linux 构建 RDAC 驱动程序』和第
51页的『安装 RDAC 驱动程序』中描述的驱动程序构建和安装过程操作。
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初始 RAMdisk 映像（initrd）
当您输入命令 make install 安装驱动程序时，将自动创建初始 RAMdisk 映像（initrd

映像）。引导装入器配置文件必须包含这个新建映像的对应条目。

initrd 映像位于引导分区中，文件名为 mpp-uname-r.img （例如，mpp-2.4.21-

9.ELsmp.img）。

对于驱动程序更新，如果系统已包含 MPP 的较早条目，系统管理员必须在引导装入器
配置文件中对现有 MPP 条目进行相应修改。大多数情况下，如果内核版本相同，不需
要进行更改。

要新建 initrd 映像，请输入 mppUpdate，该命令用新的映像文件覆盖之前的映像文件。

如果需要将第三方驱动程序添加到 initrd 映像中，请使用独立软件供应商驱动程序条目
编辑 /etc/sysconfig/kernel 文件（SUSE Linux）或 /etc/modules.conf 文件（Red Hat

Linux）。运行 mppUpdate 以创建新的 RAMdisk 映像。

添加及删除映射的逻辑驱动器（LUN）
Linux MPP 支持在不重新启动服务器的情况下重新扫描新映射的 LUN。该实用程序与
Linux MPP 驱动程序一起打包。输入 hot_add 或 mppBusRescan 命令可启动它。hot_add

命令是指向 mppBusRescan 的符号链接。这两个命令都有相应的联机资料。

Linux MPP 驱动程序不支持删除 LUN。删除映射的逻辑驱动器后，您必须重新启动服
务器。

除去临时安装文件
要从临时目录中删除临时安装文件，请使用以下某种方法：

v 重新启动主机。将在主机重新启动时删除 /tmp 文件系统中的所有条目。

v 输入以下命令：

cd /tmp
cd installation_directory_name
rm *.* -r

卸载 Storage Manager 软件
本部分包含从一个或多个 Linux 管理站或主机卸载先前版本的 Storage Manager 软件的
过程。

注：除去软件组件后，无需重新启动主机服务器。在软件删除过程中，主机将保留现
有的存储子系统映射和存储分区配置，新的客户端软件可以识别它们。

DS3000 Storage Manager 安装向导会在您已安装 Storage Manager 主机软件的目录中创
建 Uninstall 目录。此目录的缺省文件名为 /opt/IBM_DS3000。该目录包含一个名为
Uninstall_IBM_DS3000 的文件。要卸载主机软件，请转至该目录并输入以下命令：

# sh ./Uninstall_IBM_DS3000

当向导打开时，请按照指示信息操作。
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配置存储管理
安装 Storage Manager 软件后，请完成第 65页的第 8 章, 『完成 Storage Manager 软
件的安装和配置』中描述的以下任务。

v 执行首次存储子系统自动发现

v 添加存储子系统

v 命名存储子系统

v 配置警报

v 配置主机访问权

v 定义主机组

v 创建阵列和逻辑驱动器

v 管理 iSCSI 设置（仅适用于 DS3300）

v 下载控制器固件和 NVSRAM
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第 6 章 在标准 NetWare 配置中安装 Storage Manager 软件

本章描述如何在 Novell NetWare 操作系统环境中安装 Storage Manager 软件。

注：

1. 本文档发布时，DS3300 存储子系统不支持 Novell NetWare 操作系统。

2. 存储子系统控制器固件支持 DS3000 存储子系统与 NetWare 主机连接；但是本文档
发布时，NetWare 管理站尚不支持 Storage Manager 软件。

要管理连接到 NetWare 主机服务器的 DS3000 存储子系统，必须在管理站上安装 Win-

dows 或 Linux 版的 Storage Manager SMclient 程序，并建立与 DS3000 存储子系统
的频带外管理连接。要获取如何在 Windows 管理站上安装 Storage Manager Client 程
序的更多信息，请参阅第 31页的第 3 章, 『在标准 Windows 配置中安装 Storage Man-

ager 软件』或第 45页的第 5 章, 『在 Linux 配置中安装 Storage Manager 软件』。

本章描述如何安装主机总线适配器设备驱动程序、LSIMPE.cdm 驱动程序以及 NetWare

本机故障转移设备驱动程序。要实现正确安装，请完成第 21页的第 2 章, 『准备安装』
中描述的所有准备任务。

要点：安装软件之前，请务必查看针对您的操作系统的 Storage Manager 软件自述文件。
它包含本文档发布时尚不可用的重要信息。

安装 IBM 主机总线适配器设备驱动程序
IBM 主机总线适配器为主机服务器与 DS3000 存储子系统之间提供接口。IBM 主机总
线适配器是针对高端系统设计的高性能、直接存储器存取、总线主控器主机适配器。
IBM 光纤通道主机总线适配器支持所有支持专用环路、直接连接和光纤网环路连接的
IBM 光纤通道外围设备。IBM 光纤通道、iSCSI 和 SAS 主机总线适配器设备驱动程序
使操作系统能与主机总线适配器进行通信。

要获取操作系统的安装指示信息，请参阅设备驱动程序软件包随附的自述文件。要获
取更多信息，请参阅主机总线适配器随附的 Installation and User’s Guide。
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安装 LSIMPE 设备驱动程序和 NetWare 本机故障转移设备驱动程序
NetWare 本机故障转移设备驱动程序是唯一受支持的 Novell NetWare 操作系统环境故
障转移设备驱动程序。缺省情况下，NetWare 本机故障转移设备驱动程序（MM.NLM 和
NWPA.NLM）随 NetWare 6.5 一起安装。

要点：

1. 对于特定 NetWare 操作系统版本，请务必使用最新 Support Pack 中的 Novell

NetWare 本机故障转移设备驱动程序。并且，请使用最新 Novell Support Pack 中最
新版的 LSIMPE.CDM 文件或 IBM 主机总线适配器设备驱动程序 NetWare 版提供
的版本（可从 IBM DS3000 支持 Web 站点下载）。

2. 要获取有关故障转移/故障恢复配置和设置的最新指示信息，请参阅 Storage Man-

ager 自述文件。

通过在 Novell NetWare 环境中使用 LSIMPE.CDM 设备驱动程序，Novell 本机多路径
设备驱动程序可以识别 DS3000 存储子系统上创建的 NetWare 主机映射逻辑驱动器。
LSIMPE.cdm 设备驱动程序是一个定制驱动程序模块，它包含在 IBM DS3000 主机总
线适配器设备驱动程序和 Novell 操作系统分发版 CD 中。

要获取最新的 LSIMPE.cdm 设备驱动程序，请参阅 IBM 主机总线适配器设备驱动程序
自述文件。您可以在 http://www.ibm.com/servers/storage/support/disk/ 找到最新的自述文
件。

注：在 DS3000 控制器中不可以使用 Novell NetWare 6.5 Service Pack 7 的嵌入式
lsimpe.cdm 设备驱动程序。要执行故障转移并使其正确运作，就必须使用 http://

support.novell.com/docs/Readmes/InfoDocument/patchbuilder/readme_5006860.html 中
的文件。
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第 7 章 将 DS3000 存储子系统与 VMware ESX Server 配置结
合使用

要点：本文档发布时，DS3000 Storage Manager 软件还不能用于 VMware ESX Server

操作系统。因此，要使用 VMware ESX Server 主机管理 DS3000 存储子系统，
必须在 Windows 或 Linux 管理工作站上安装 Storage Manager Client 软件
（SMclient）。（该工作站可以是用于基于 Web 的 VMware 管理界面的同一台
工作站。）

要获取在 Windows 或 Linux 管理站上安装 DS3000 Storage Manager 2 Client 软件
（SMclient）的指示信息，请参阅第 31页的第 3 章, 『在标准 Windows 配置中安装
Storage Manager 软件』或第 45页的第 5 章, 『在 Linux 配置中安装 Storage Man-

ager 软件』。

要获取将 DS3000 存储子系统与 VMware ESX Server 主机结合使用的更多信息，请参
阅 Storage Manager 软件自述文件。

样本配置
图 10 显示样本 VMware ESX Server 配置。

图 10. VMware ESX Server 配置示例
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软件要求
本部分描述将 VMware ESX Server 主机操作系统与 DS3000 存储子系统结合使用所需
的软件。

管理站
Windows 或 Linux 管理站需要以下软件：

1. SMruntime（仅适用于 Linux）

2. SMclient（Windows 和 Linux）

注：VMware 的映射存储分区主机类型为 lnxclvmware。

主机（VMware ESX Server）
ESX Server 需要以下软件：
VMware ESX Server 2.5.4、VMware ESX Server 3.0.1、VMware ESX Server

3.0.2、VMware ESX Server 3.5、VMware ESX Server 3.5.1 和 VMware ESX Server

3.5.2

要了解 VMware ESX Server 限制，请参阅 Storage Manager 软件自述文件。

注：

1. 将 VMware 工具用于访客操作系统软件。

2. VMware ESX Server 3.5.1 或更高版本支持 DS3200 存储子系统。

3. VMware ESX Server 3.5 或更高版本支持 DS3300 存储子系统。

集群
要获取 Windows 集群与 VMware ESX Server 结合使用的信息，请参阅位于 http://

www.vmware.com/support/pubs/ 的 ESX Server Installation Guide。

配置存储子系统
配置存储子系统之前，首先必须在硬件上配置主机服务器、SAN 光纤网和 DS3000 控
制器（DS3200 不需要 SAN 光纤网）、为控制器指定初始 IP 地址，并在 Windows 或
Linux 管理站上安装 SMclient。本文档的以下部分描述了这些过程。

设置 VMware ESX Server 主机
要获取设置 VMware ESX Server 主机的更多信息，请参阅 http://www.vmware.com/

support/pubs/ 处提供的文档和自述文件。

要获取在 IBM 服务器上安装 VMware ESX Server 操作系统的信息，请访问 http://

www.ibm.com/systems/support/。

设置 SAN 光纤网
要获取设置 SAN 光纤网的信息，包括分区信息，请参阅 http://www.vmware.com/support/

pubs/。

指定初始 IP 地址
有关向 DS3000 控制器指定初始 IP 地址的信息，请参阅第 25页的『步骤 3：指定主
机和控制器 IP 地址』。
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在 Windows 或 Linux 管理站上安装 SMclient
要获取在 Windows 管理站上安装 SMclient 的信息，请参阅第 31页的第 3 章, 『在标
准 Windows 配置中安装 Storage Manager 软件』。

要获取在 Linux 管理站上安装 SMclient 的信息，请参阅第 45页的第 5 章, 『在 Linux

配置中安装 Storage Manager 软件』。

完成存储管理安装和配置
要获取完成存储管理安装和配置任务的信息，请参阅第 65页的第 8 章, 『完成 Stor-

age Manager 软件的安装和配置』。

将 LUN 映射到存储分区
本部分包含特定于 VMware ESX Server 的 LUN 映射相关注意事项。要了解关于如何
将 LUN 映射到分区的过程，请参阅第 76页的『将 LUN 映射到分区』。

在 VMware 上映射 LUN 时，请注意以下信息：

v 必须在每个分区上映射一个 LUN 0。

v 确保从 LUN 0 开始，使用连续数字映射 LUN。例如，将 LUN 映射到数字
0、1、2、3、4、5 等等，不跳过任何数字。

v 仅在配置启用 VMotion 的主机时才支持跨多个 ESX Server 的 LUN 共享。在映射
到多个 ESX Server 的 LUN 上，您必须将访问方式更改为 Shared。可以为 ESX

Server 将 LUN 映射到一个主机组，这样主机组的所有成员即可使用它们。要获取
Windows 集群与 ESX Server 结合使用的更多信息，请参阅位于 ht tp : / /

www.vmware.com/support/pubs/ 的 ESX Server Installation Guide。

VMware 故障转移设置说明
在连接 VMware 主机的 DS3200 或 DS3400 存储子系统中，您可以使用的唯一支持故
障转移的机制就是 MRU（最近使用）。

注：新建 VMware 访客操作系统分区时所选中的缺省故障转移为 MRU，因此无需进行
更改。

MRU 故障转移机制支持路径故障转移和路径恢复，但无法进行自动恢复。

要重新平衡 LUN，请完成以下步骤：

1. 选择 Storage Manager 2 软件并打开 Subsystem Management 窗口。

2. 单击 Support 选项卡。

3. 依次选择 Manage Controllers 和 Redistribute Logical Drives。

如果在故障转移机制中选择 Fixed，就无法自动恢复到首选路径。初始问题后发生的
任何后续故障将导致您无法访问分配到非首选路径的逻辑驱动器。
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VMware iSCSI Software Initiator 配置说明
要配置 VMware iSCSI Software Initiator，请完成以下步骤：

1. 为 Software Initiator 创建 VMkernel 端口。

2. 创建虚拟交换机，然后选择虚拟交换机要使用的网络适配器。

3. 输入 IP 地址和子网掩码，进行 IP 设置。

在为 Software Initiator 设置目标发现地址时，如果正在使用多个网络，那么针对每个网
络，用一个地址。

下图显示了一个样本配置，其中指定 VNIC 0 和 VNIC 1 使用同一个虚拟交换机（Vir-

tual switch 0）。该配置支持主机访问 DS3300 上的所有端口。

图 11. 样本配置显示 VNIC 0 和 VNIC 1 使用同一个虚拟交换机
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下图显示了一个样本配置，其中指定 VNIC 0 和 VNIC 1 位于不同网络。必须为
DS3300 上的端口指定 IP 地址，以便 DS3300 上的每个控制器中至少有一个端口对于
每个网络是可访问的。

有关设置 iSCSI Software Initiator 的更多信息，请参阅 http://www.vmware.com/pdf/

vi3_35/esx_3/r35/vi3_35_25_iscsi_san_cfg.pdf。

配置 SAS HBA BIOS 超时设置以使故障转移正确运行
在 VMware 环境中执行大量 I/O 操作时，为确保 DS3200 存储子系统提供正确的路径
故障转移，您必须重新配置 SAS HBA BIOS 中的两个超时值。如果未能成功配置 SAS

HBA BIOS 的两个超时值，那么将会导致 I/O 超时。您必须更改 Report Device Miss-
ing Delay 和 I/O Device Missing Delay 的值。

要更改 SAS HBA BIOS 超时设置，请完成以下步骤：

1. 使用 SAS HBA 重新启动主机。

2. 当您在 POST 期间收到提示，请按 Ctrl+C 以启动 LSI Corp（SAS）配置实用程序。

注：如果您遇到“PCI 资源分配错误”，使得配置实用程序无法初始化，那么您可能
不得不禁用某些 PCI 设备或控制 ROM 执行空间。这条错误消息表明系统 ROM

空间已满，无多余的 ROM 空间用于其他适配器。要了解更多信息，请参阅位
于 http://www.ibm.com/systems/support/ 上的 『1801 PCI Allocation Errors』 的
Retain Tips。

3. 在 Adapter List 页面上，使用方向键选择 SAS HBA，然后按 Enter 键。这会显示
Adapter Properties 页面。

4. 选择 Advanced Adapter Properties，然后按 Enter 键。

5. 选择 Adapter Timing Properties，然后按 Enter 键。

6. 通过按 + 键、- 键或空格键，将 Report Device Missing Delay 的值改为 10 秒。

图 12. 样本配置显示 VNIC 0 和 VNIC 1 位于不同网络
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7. 通过按 + 键、- 键或空格键，将 IO Device Missing Delay 的值改为 0 秒。

注：对于 VMware ESX Server 3.5.2，将 Report Device Missing Delay 的值改
为 144 秒，并将 IO Device Missing Delay 的值改为 8 秒。

8. 对于主机服务器中的每个 SAS HBA，重复步骤 第 61页的3 至步骤 7。

为 VMware Windows 访客操作系统配置 DS3000 存储子系统控制器检测数
据

您可以配置 DS3000 存储子系统控制器，以在静默情况下，返回 Unit Attention 或 Not

Ready 消息。对于运行 Windows 作为访客操作系统的 DS3000 控制器，在静默情况下，
返回 Not Ready 检测数据。返回 Unit Attention 检测数据可能会在执行故障转移操作
期间导致 Windows 访客操作系统发生故障。

注：由于可能会使用命令 shell（如下列过程所述），因此您可以使用 DS3000 Storage

Manager 软件中的 Script Editor。

要配置 DS3000 控制器以返回 Not Ready 检测数据，请完成以下步骤：

1. 将目录路径更改为 SMcli 可执行文件所在的位置。

2. 在管理站的 shell 窗口中，输入下列命令，以确定 VMLNXCL 主机类型的索引：

SMcli ip_addr_for_controllerA ip_addr_for_controllerB
-c "show storagesubsystem hosttopology";

按 Enter 键。

3. 输入下列命令，以使控制器 A 可以返回 Not Ready 检测数据。输入所有命令之后，
只需按 Enter 键。

注：

v 在下列命令中，值 13 用于 NVSRAM 主机类型定义中的 VMLNXCL 相关的索
引，其中该主机类型定义由下列命令返回。如果您的控制器为 VMLNXCL 使用了
其他索引值，那么在下列命令中使用该索引值代替 13。

v 以下命令用于重置控制器。控制器将暂时不可用，直至控制器重置操作完成。

SMcli ip_addr_for_controllerA ip_addr_for_controllerB
-c "set controller [a] hostNVSRAMBYTE [13,0x12]=0x01;
set controller [a] hostNVSRAMBYTE [13,0x13]=0x00;
reset Controller [a]";

在执行下一个步骤之前，请稍等片刻，直至控制器 A 重新启动完成，并且存储子系
统状态为 Optimal。
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4. 输入下列命令，以使控制器 b 可以返回 Not Ready 检测数据。输入所有命令之后，
只需按 Enter 键。

注：以下命令用于重置控制器。控制器将暂时不可用，直至控制器重置操作完成。

SMcli ip_addr_for_controllerA ip_addr_for_controllerB
-c "set controller [b] hostNVSRAMBYTE [13,0x12]=0x01;
set controller [b] hostNVSRAMBYTE [13,0x13]=0x00;
reset Controller [b]";

VMware 的所需更新
在执行了大量的 I/O 重试操作或 ESX Server 主机存储器的路径故障转移之后，Red Hat

Enterprise Linux 5 访客操作系统文件系统可能会变为只读。要获取更多信息，请参阅
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC

&externalId=1001778。
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第 8 章 完成 Storage Manager 软件的安装和配置

本章提供了使用 Storage Manager 2 软件的 Enterprise Management 和 Subsystem Man-

agement 功能部件完成 Windows、Linux 和 NetWare 操作系统环境的安装任务的相关
信息。

注：本文档发布时，DS3000 Storage Manager 2 软件还不能用于 NetWare 操作系统。
要使用 NetWare 主机配置 Storage Manager 2 软件，请使用 Windows 或 Linux

管理站上的 SMclient 完成本部分中的任务。

要完成 Storage Manager 2 软件安装，请执行以下任务。以下部分将详细讨论这些任务。

1. 执行存储子系统发现。

2. 根据需要添加设备。

3. 根据需要设置警报通知。

4. 命名存储子系统。

5. 下载固件和 NVSRAM。

6. 创建阵列和逻辑驱动器。

7. 配置异构主机。

8. 将逻辑驱动器映射到分区。

9. 执行其他存储子系统任务。

启动 Storage Manager 软件并找到存储子系统
要启动 Storage Manager 软件并找到存储子系统，请完成以下步骤：

1. 选择以下某个命令：

v Windows：单击开始 → 程序 → Storage Manager 2 Client。

v Linux：输入 /opt/IBM_DS3000/client/SMclient（缺省情况下）。

将启动客户端软件并打开 Enterprise Management 窗口。然后，在 Enterprise Man-

agement 窗口的顶部会打开 Task Assistant 窗口（如第 68页的图 15 所示）和 Select

Addition Method 窗口（如第 66页的图 13 所示）。
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2. 选择 Automatic 可发现连接到本地子网的所有主机和存储子系统。选择 Manual 可
指定连接到本地子网的设备的 IP 地址。

注：首次自动发现后，刷新 Enterprise Management 窗口最长需要 1 分钟。

3. 确保 Enterprise Manager 窗口中显示了所有主机和存储子系统。

如果某个主机或存储子系统未显示，请完成以下任务：

v 检查硬件和硬件连接是否存在可能问题（请参阅硬件文档获取特定过程）。

v 要获取发现存储子系统的更多信息，请参阅 Enterprise Management 联机帮助。

v 如果正在使用直接管理方法，请确保所有主机和存储子系统都连接到同一子网。
如果正在使用主机代理方法，请确保主机与存储子系统之间已建立 I/O 连接。

v 确保已完成第 21页的第 2 章, 『准备安装』中为直接管理系统设置存储子系统的
所有准备步骤。如果已完成，请使用 Add Device 选项添加存储子系统的 IP 地
址。添加控制器的两个 IP 地址。否则，当您尝试管理存储子系统时，会显示 par-

tially-managed device 错误消息。

v 如果要使用主机代理管理方法，请完成以下步骤：

a. 确保主机上已安装 SMagent。

b. 确保存储子系统与安装 SMagent 的主机之间已建立有效的 I/O 连接。

c. 确保已完成第 21页的第 2 章, 『准备安装』中列出的所有准备步骤。如果已
完成，请完成以下步骤：

图 13. Select Addition Method 窗口
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1) 运行 hot_add 实用程序。

2) 使用第 99 页的『停止并重新启动主机代理软件』中的信息，重新启动
SMagent。

3) 在 Enterprise Management 窗口中单击主机，然后
单击 Tools → Rescan。

注：在特定情况下，自动发现后设备树中可能出现重复的存储子系统。可以使用
Enterprise Management 窗口中的 Remove Device 选项从设备树中除去重复的存
储管理图标。

4. 确保每个存储子系统的状态均为 Optimal。如果某个设备的状态显示为 Unrespon-

sive，请右键单击该设备并选择 Remove Device，从管理域中删除它。然后使用
Add Device 选项将它再次添加到管理域中。要获取除去和添加设备的指示信息，请
参阅 Enterprise Management 窗口联机帮助。

图 14 显示了首次自动发现后的 Enterprise Management 窗口。

使用 Task Assistant
启动 Storage Manager 软件时，将启动客户端软件并打开 Enterprise Management 窗口。
然后，Task Assistant 窗口将打开并提供一个中心位置，您可以从该位置选择执行最常见
的任务。

注：除非您选中 Task Assistant 窗口底部的 Don’t show the task assistant at
start-up again 复选框，否则每次打开 Enterprise Management 窗口时都会自动打
开 Task Assistant 窗口。

图 14. Enterprise Management 窗口
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Task Assistant 提供以下任务的快捷方式：

v 添加存储子系统

v 命名或重命名存储子系统

v 配置警报

v 管理存储子系统

图 15 显示了 Enterprise Management Window Task Assistant。

要在启动 Storage Manager 软件之后打开 Task Assistant，请在 Enterprise Management

窗口中单击 View → Task Assistant，或在工具栏上单击 Task Assistant 图标

。

图 15. Enterprise Management Window Task Assistant
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添加存储子系统
要手动添加更多主机或存储子系统，请在 Enterprise Management 窗口中单击 Edit →
Add Storage Subsystem。您可以使用这个选项有选择地管理 Storage Manager Cli-

ent 的一组存储子系统，还可以添加要进行管理但首次发现过程中未发现的设备。要获取
更多信息，请参阅 Enterprise Management 窗口联机帮助。

要点：

v 当您添加未识别设备时，将打开一个窗口确认该设备已成功添加并且您可以管理该
存储子系统。正确发现未识别设备组中列出的任何设备之前，您无法管理这些设
备。确保已建立连接并再次尝试添加设备。

v 当您将新的存储子系统添加到 SAN 中的现有存储子系统并且通过主机代理软件来管
理 SAN，您必须停止并重新启动主机代理服务。当主机代理服务重新启动时，将检测
到新的存储子系统。要获取更多信息，请参阅第 99页的『停止并重新启动主机代理
软件』。然后，转至 Enterprise Management 窗口并单击 Tools → Rescan，将新的
存储子系统添加到管理域。

v 当您将新的存储子系统添加到通过直接（频带外）管理方法管理的现有存储子系
统，请务必指定两个控制器的 IP 地址。

命名存储子系统
要命名存储子系统，请完成以下步骤：

1. 在 Enterprise Management 窗口中，选择某个存储子系统，用鼠标右键单击存储子系
统，然后选择 Rename。这时将打开 Rename Storage Subsystem 窗口。

图 16. Rename Storage Subsystem 窗口
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2. 输入存储子系统的名称（请参阅第 105页的表 12）。然后单击 OK。将显示一条警告
消息，指出更改存储子系统名称可能导致主机应用程序无法访问该存储子系统。单
击 Yes 继续，或单击 No 取消命名存储子系统。

3. 为每个未命名的存储子系统重复该过程。要获取更多信息，请参阅 Subsystem Man-

agement 窗口联机帮助中重命名存储子系统的相关主题。

配置警报
将设备添加到管理域后，您可以设置警报通知以报告存储子系统的重大事件。提供以
下警报通知选项：

v 通过简单网络管理协议（SNMP）陷阱向指定网络管理站（NMS）发送通知

v 向指定电子邮件地址发送通知

注：只能在管理域中监控存储子系统。如果未安装 Event Monitor 服务，那么 Enter-

prise Management 窗口必须保持打开。如果关闭该窗口，您将无法从管理的存储子
系统收到任何警告通知。要获取更多信息，请参阅 Enterprise Management 窗口联
机帮助。

要设置警报通知，请在 Enterprise Management 窗口中单击 Edit → Configure Alerts。

要通过使用 SNMP 陷阱将警报通知设置为向网络管理站（NMS）发送通知，请完成以
下步骤：

1. 将 IBM System Storage DS3000 支持 CD 插入 NMS 的 CD 驱动器中。指定管理
站只应设置一次。

2. 将文件 SM2.MIB 从 SM2MIB 目录复制到 NMS。

3. 按照 NMS 要求的步骤操作以编译管理信息基本程序（MIB）文件。要获取更多信
息，请与您的网络管理员联系或参阅存储管理软件随附的文档。

Initial Setup Tasks 窗口
从 Subsystem Management 窗口可以打开 Initial Setup Tasks 窗口，其中包含到以下任
务的链接：

v 定位存储子系统

v 重命名存储子系统

v 设置存储子系统密码

v 配置主机访问权

v 管理 iSCSI 设置（仅适用于 DS3300）

v 配置存储子系统

要打开“Initial Setup Tasks”窗口，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击要执行设置任务的存储子系统。这时将打开
Subsystem Management 窗口。

2. 单击 Summary 选项卡。
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3. 在 Summary 页面上，单击 Perform Initial Setup Tasks。这时将打开 Initial Setup

Tasks 窗口，如图 17 所示。

注：除非您选中 Initial Setup Tasks 窗口底部的 Do not show this again for this
storage subsystem 复选框，否则每次打开 Subsystem Management 窗口时都会
自动打开 Initial Setup Tasks 窗口。

创建存储子系统概要文件
要点：当您修改存储子系统中的阵列和逻辑驱动器时，请创建存储子系统概要文件并
妥善保存。这个概要文件包含逻辑和物理磁盘配置信息等具体的控制器信息，它们可
以帮助您在发生故障时恢复配置。请勿将概要文件保存在收集和保存其概要文件的
DS3000 存储子系统中创建的逻辑驱动器中。

要保存存储子系统概要文件，请完成以下步骤：

图 17. Subsystem Management 窗口中的 Initial Setup Tasks 窗口
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1. 在 Subsystem Management 窗口中，单击 Summary → Storage Subsystem Pro-
file。这时将打开 Storage Subsystem Profile 窗口。

2. 单击 Save As。

3. 选择要保存的部分并提供用于保存概要文件的文件名。

您也可以单击 Support → Gather Support Information，如图 18 所示，从存储子系
统收集清单、状态、诊断和性能数据并将它们保存到一个压缩文件中。

配置主机访问
使用主机服务器中的逻辑驱动器之前，您必须定义及配置要访问的主机。

要配置主机访问，请完成以下步骤：

1. 单击 Subsystem Management 窗口中的 Configure 选项卡。选择以下某个选项：

v 要自动配置主机访问，请单击 Configure Host Access (Automatic) 并根据向
导指示信息操作。按照向导中的指示信息完成操作后，本过程结束。

注：要自动检测主机，Storage Manager 2 Agent 服务必须处于运行状态。继续之
前，请确保已安装 SMagent。

v 要手动配置主机访问，请单击 Configure Host Access (Manual) 并继续至步
骤 2。

2. 启动 Configure Host Access (Manual) 向导时，指定主机名和主机类型，然后单击
Next。

注：使用主机服务器中的逻辑驱动器之前，必须指定正确的主机类型。主机类型可
决定存储子系统控制器与控制器所连接主机上的各个操作系统的配合方式。欲
了解支持的主机类型，请参阅 Storage Manager 软件自述文件。

图 18. Gather Support Information 窗口
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3. 显示 Specify HBA Host Ports 区域时，请在 Selected HBA host port iden-
tifiers/aliases 字段中添加已知或新的主机总线适配器，然后单击 Next。

4. （可选）显示 Specify Host Group 区域时，指定将与逻辑驱动器共享访问权的主
机组。指定主机组时，您可以新建主机组或选择已定义的现有主机组。选择 No 或
Yes，然后单击 Next。

定义主机组
主机组是存储分区拓扑中的一个实体，它定义了主机服务器的逻辑集合，这些服务器
要求对一个或多个逻辑驱动器进行共享访问。您也可以向已定义主机组中的个别主机
授予对未由其他节点共享的其他逻辑驱动器的访问权，但这需要额外的存储分区。可
以与主机组或主机组中的个别主机建立逻辑驱动器至 LUN 映射。

要点：如果您已购买存储分区高级功能部件，请确保启用该高级功能部件。如果您无
法启用该高级功能部件，请参阅密钥随附的高级功能部件启用指示信息，或与
您的技术支持代表联系。

注：您可以在定义主机组时配置异构主机。这样，运行于不同操作系统上的主机可以
访问同一个存储子系统。

要定义主机组，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Configure → Create Host Group 启动
Create Host Group 向导。

2. 显示 Create Host Group 区域时，输入主机组的名称并将所有可用的主机添加到
该主机组中。

3. 单击确定。

注：要在此时将主机添加到主机组，必须已配置用于访问的可用主机。可以首先创
建一个主机组而不添加主机，今后使用 Create Host Access (Manual) 向导添加
主机。要获取更多信息，请参阅第 72页的『配置主机访问』。

创建阵列和逻辑驱动器
独立磁盘冗余阵列（RAID）阵列是一组按逻辑分类的硬盘驱动器。

逻辑驱动器是您为保存存储子系统上的数据而创建的基本逻辑结构。操作系统将逻辑
驱动器识别为单个驱动器。选择相应的 RAID 级别以满足应用程序对数据的可用性需求
并实现 I/O 性能最大化。

一个阵列最多支持 30 个驱动器。每个阵列可以分为 1-256 个逻辑驱动器。
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要创建阵列和逻辑驱动器，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Configure 选项卡。

3. 单击 Create Logical Drives。将启动 Create Logical Drives 向导并打开 Select

Capacity Type 窗口。

4. 选中 Unconfigured capacity 或 Free capacity，然后单击 Next。

注：如果选中 Free capacity，必须首先从现有阵列中选择可用容量节点，然后才
能继续执行向导操作。

如果选择 Unconfigured capacity，请跳至步骤 第 76页的 10。

5. 在 Select drive type 列表中选择 SAS 或 SATA。

图 19. Create Logical Drives 向导窗口
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注：必须使用具有相同磁盘类型的驱动器来创建阵列。您无法在同一个阵列中同
时使用 SATA 和 SAS 驱动器。

6. 显示 Drive Selection Choices 区域时，选择 Automatic 或 Manual，然后单
击 Next。如果选择 Automatic，请继续执行步骤 7。如果选择 Manual，请跳至
步骤 8。

注：建议选择 Automatic，这样可以快速、简便地进行配置。这种方法允许您从自
动生成的驱动器列表和容量选项中进行选择。高级用户可使用 Manual 选项指
定用于新建阵列的驱动器。

7. 显示 Choose Configuration (Automatic Configuration) 区域时，选择 RAID

级别并单击 Finish。

注：自动配置会根据选定的 RAID 级别，配置存储子系统中当前可用的所有剩余未
配置容量。查看 Configuration summary 字段可了解即将配置项的详细信
息。

8. 显示 Manual Drive Selection 区域时，如第 76页的图 21 所示，选择 RAID 级
别。从 Unselected drives 区域中选择驱动器，然后单击 Add 将它们移至
Selected drives 区域中。在 Selected drives 区域中，单击 Calculate Capac-
ity，然后单击 Next。

图 20. 选择容量类型
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9. 显示 Specify Logical Drive 区域时，为逻辑驱动器指定容量、名称和 I/O 特性，
然后单击 Next。

10. 显示 Map Logical Drive To Host 区域时，选择 Map now 立即映射逻辑驱动
器或使用 第 72页的『配置主机访问』 中定义的主机或选择 Map later 稍后映射
逻辑驱动器，然后单击 Next。

注：

a. 如果您之前未配置主机，将显示一条警告消息。阅读消息后单击 OK；然后继续
Create Logical Drives 向导操作。

b. 要现在映射逻辑驱动器，必须先前已配置主机或主机组（继续之前，请确保为
逻辑驱动器指定 LUN 编号）。如果选择 Map later，您可以通过 Create Host-

to-Logical Drive Mappings 向导映射逻辑驱动器。要获取更多信息，请参阅『将
LUN 映射到分区』。

注：对于集群配置，如果添加或删除逻辑驱动器，必须告知节点 A 和 B。

将 LUN 映射到分区
当逻辑单元号（LUN）映射到分区时，它们被指定给各个逻辑驱动器。

要将 LUN 映射到新分区或现有分区，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Configure → Create Host-to-Logical
Drive Mappings 启动向导。

2. 显示 Select Host 区域时，选择主机或主机组，然后单击 Next。

图 21. Manual Drive Selection 区域
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3. 显示 Select Logical Drives 区域时，选择要映射到指定主机的逻辑驱动器，然后
单击 Finish。

配置热备用设备
您可以将存储子系统中可用的物理设备指定为热备用驱动器，以保证数据的可用性。
热备用驱动器是一个不包含任何数据的驱动器，它作为备用设备，以免阵列中某个驱
动器发生故障。如果阵列中某个驱动器发生故障，那么在存储子系统运行期间，控制
器会自动使用热备用驱动器来替换发生故障的驱动器。控制器利用冗余数据自动地重
构故障驱动器上的数据，并将数据保存在热备用驱动器中。这称为重构。

热备用驱动器为存储子系统增添了另一层面的冗余。如果存储子系统中的驱动器发生
故障，那么将自动使用热备用驱动器来替换故障驱动器，无需进行物理切换。如果逻
辑驱动器发生故障时有可用的热备用驱动器，那么控制器会利用冗余数据重构故障逻
辑驱动器上的数据，并将数据保存在热备用驱动器中。在更换故障驱动器或指定另一
个驱动器为代替驱动器之后，那么热备用驱动器中的数据将回写至这个代替驱动器
中。这称为回写。

图 22. 创建主机区域
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要指定热备用驱动器，请打开 Subsystem Management 窗口，单击 Configure 选项卡，
然后选择下面某个选项：

v Automatically assign drives。如果选择该选项，那么将利用可用的驱动器自动创
建热备用驱动器，以取得最佳的热备用效果。

v Manually assign individual drives。如果选择该选项，那么将采用手工方式在 Con-

figure Hot Spares 窗口中进行选择，从可用的驱动器里选出一个驱动器做热备用驱动
器。

如果您选择手动指定热备用驱动器，那么所选的驱动器容量应大于等于要热备的驱动
器总容量。为了使受保护数据的容量达到最大，如果驱动器的容量小于存储子系统上
最大驱动器的容量，那么请不要将该驱动器指定为热备用驱动器。在兼备不同容量的
硬盘驱动器配置中，仅将具有最大容量的驱动器用于热备用驱动器。

更换磁盘驱动器
如果某个磁盘驱动器发生故障，并且有可用的热备用驱动器，那么热备用将启动重构
过程，临时替换故障驱动器。利用可配置的驱动器替换策略，您可以选择下面某个选
项：

v 用代替驱动器替代故障驱动器。这个代替驱动器将利用热备用驱动器执行回写操
作，成为阵列的成员。

v 从 Replace Drive 窗口（位于 Modify 选项卡），选择当前属于降级阵列的热备用驱
动器，将其设置为该阵列的永久成员。

v 从 Replace Drive 窗口（位于 Modify 选项卡），选择存储机柜中另一个可用驱动器，
将它指定为代替驱动器。该驱动器将利用热备用驱动器来执行回写操作，成为该阵
列的成员。

注：在热备用驱动器重构过程完成之前，不能选择代替驱动器。
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管理 iSCSI 设置（仅适用于 DS3300）

注：Subsystem Management 窗口中的 iSCSI 选项卡仅适用于 DS3300 存储子系统。

在 Subsystem Management 窗口中，单击 iSCSI 选项卡。将打开一个类似于下图的窗
口。

iSCSI 页面中具有以下选项：

v Change Target Authentication

v Enter Mutual Authentication Permissions

v Change Target Identification

v Change Target Discovery

v Configure iSCSI Host Ports

v View/End iSCSI Sessions

v View iSCSI Statistics

图 23. Manage ISCSI Settings 页面
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更改目标认证
选择 Change Target Authentication 指定发起方在 iSCSI 登录的安全性协商阶段必
须使用的目标提问握手认证协议（CHAP）密钥。缺省情况下选择 None。要更改此选
择，单击 CHAP，然后输入 CHAP 密钥。如有需要，可以选择此选项生成随机密钥。
这将启用单向 CHAP。

输入相互认证权限
在选择 Enter Mutual Authentication Permissions 之前，必须为启动器定义主机端
口并启用 Target Authentication。列出主机端口后，从列表中选择主机，然后单击
Chap Secret 指定从目标传送到发起方用以认证此主机的密钥。这将启用相互型 CHAP

（双向）。

更改目标认证
选择 Change Target Identification 指定在设备发现期间所使用的目标别名。为目标
指定的名称必须是唯一的且由字符数小于 30 的字符串组成。

注：使用别名上方列出的标准 IQN 连接到目标。

更改目标发现
选择 Change Target Discovery，使用 iSCSI 简单命名服务（iSNS）执行设备发现任
务。选择此选项后，选中 Use iSNS Server 复选框。还可以选择是否使用网络上的
DHCP 服务器来发现 iSNS 服务器，并且可以手动指定因特网协议 V4（IPv4）或 IPv6

地址。在您单击 Advanced 选项卡时，可以为 iSNS 服务器指定其他 TCP/IP 端口，
从而进一步增强安全性。

注：要为正确的设备发现提供所需的端口登录信息，所有的 iSCSI 端口都必须能够与同
一个 iSNS 服务器通信。

配置 iSCSI 主机端口
选择 Configure iSCSI Host Ports 以配置所有的 TCP/IP 设置。可以选择在所有的
端口上启用或禁用 IPv4 和 IPv6。也可以静态分配 IP 地址或使用 DHCP 发现这些地
址。在 Advanced IPv4 Settings 下，可以分配 VLAN 标记（802.1Q）或设置以太
网优先级（802.1P）。在 Advanced Host Port Setting 下，可以为此目标端口指定唯
一的 iSCSI TCP/IP 端口。也可以通过此选项启用超长帧。支持的帧大小是 1500 和
9000。

查看或结束 iSCSI 会话
选择 View/End iSCSI Sessions 查看所有与目标连接的 iSCSI 会话。在此页面上，
还可以通过强制目标 ASYNC 从发起方会话注销来关闭现有会话。

查看 iSCSI 统计信息
选择 View iSCSI Statistics 查看所有 iSCSI 会话数据的列表，例如，标题摘要错误
数、数据摘要错误数以及成功的协议数据单元数。也可以在进行纠正操作之后设置一
个基线计数以确定问题是否得以解决。
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确定固件级别
有两种方法可用于确定 DS3000 存储子系统、扩展单元、驱动器和 ESM 固件的版本。
每种方法都使用 Storage Manager Client，它通过连接的扩展单元来管理 DS3000 存储
子系统。

方法 1
打开 Subsystem Management 窗口，然后单击 Summary 选项卡。在 Hardware Com-
ponents 区域选择 Storage Subsystem Profile。当 Storage Subsystem Profile 窗口
打开时，选择以下某个选项卡来查看固件信息。

注：Storage Subsystem Profile 窗口包含整个子系统的所有概要信息。因此，您可能需要
滚动浏览大量数据才能找到所需的信息。

Summary

v Firmware version（控制器固件）

v NVSRAM version

以下示例显示 Summary 页面上的概要信息。

图 24. Summary 页面上的概要信息示例
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Controllers

v Firmware version

v Appware version（Appware 引用控制器固件）

v Bootware version（Bootware 引用控制器固件）

v NVSRAM version

以下示例显示 Controllers 页面上的概要信息。

Enclosures

v Firmware version

以下示例显示 Enclosures 页面上的概要信息。

图 25. Controllers 页面上的概要信息示例

图 26. Enclosures 页面上的概要信息示例
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Drives

v Firmware version（驱动器固件）

以下示例显示 Drives 页面上的概要信息。

方法 2
打开 Subsystem Management 窗口，在“支持”页面上选择 Download Firmware。选
择以下某个选项查看固件信息。

注：方法 2 仅用于确保固件版本正确无误。检查固件版本后，请取消或关闭窗口，防止
不慎下载固件。

Download controller firmware

v Firmware version（控制器固件）

v NVSRAM version

Download NVSRAM

v NVSRAM version

Download drive firmware

v Firmware version（驱动器固件）

Download Environmental Services Monitor (ESM) firmware

v Enclosure firmware version

下载控制器、NVSRAM、ESM 和硬盘驱动器固件

注：您可以从 http://www.ibm.com/servers/storage/support/disk/ 下载最新版本的 DS3000

存储子系统控制器固件、NVSRAM、EXP3000 ESM 和硬盘驱动器固件。

要点：

1. IBM 支持下载控制器固件和采用 I/O 的控制器 NVSRAM（在双控制器配置中），
这种方式有时称为并发固件下载。进行并发固件下载之前，请参阅固件代码或
DS3000 Storage Manager 主机软件随附的自述文件，了解这种方式的所有限制。

图 27. Drives 页面上的概要信息示例
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2. 将固件和 NVSRAM 下载到使用单控制器的 DS3000 存储子系统时，请停止所有 I/O

活动，否则主机服务器与 DS3000 存储子系统之间的连接会丢失。

本部分提供下载 DS3000 存储子系统控制器固件和 NVSRAM、EXP3000 ESM 固件以
及驱动器固件的指示信息。DS3000 存储子系统固件下载通常从控制器固件开始，随后
依次为 NVSRAM、ESM 固件以及硬盘驱动器固件。

下载控制器或 NVSRAM 固件
要下载 DS3000 存储子系统控制器固件和 NVSRAM，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Support → Download firmware → Download Controller Firmware。这时
将打开 Download Controller Firmware 窗口，如图 28 所示。

3. 要选择控制器固件文件，单击 Selected controller firmware file 字段旁的 Select
File，然后浏览到要下载的文件。

4. 要选择 NVSRAM 文件，单击 Selected NVSRAM file 字段旁的 Select File，然
后浏览到要下载的文件。

要使用控制器固件传输 NVSRAM 文件，选中 Transfer NVSRAM file with con-
troller firmware 复选框。

5. 单击 Transfer。

图 28. Download Controller Firmware 窗口
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下载 ESM 固件
要下载 ESM 固件，请完成以下步骤。

注：必须在所有 I/O 空闲的情况下才可下载 ESM 固件。

1. 在 Subsystem Management 窗口中，单击 Support → Download firmware → Down-
load Environmental (ESM) Card Firmware。这时将打开 Download Environmen-

tal (ESM) Card Firmware 窗口。

2. 选中 Select All 复选框可对所有机箱执行下载。您也可以选择一个机箱，或通过按
住 Ctrl 键来选择一组机箱。

3. 要选择 ESM 固件文件，请单击 Selected ESM firmware file information字段旁
的 Select File，然后浏览到要下载的文件。

4. 单击 Start 开始 ESM 固件下载。这时将打开 Confirm Download 窗口。

5. 输入 yes 并单击 OK 开始下载过程。

6. 完成所有选定机箱的 ESM 固件下载后，单击 Close。

ESM 固件自动同步
当您将新的 ESM 安装到现有的存储扩展箱中，而该扩展箱又连接到支持 ESM 固件自
动同步的 DS3000 存储子系统时，新 ESM 中的固件将与现有 ESM 中的固件自动同
步。这可以自动解决所有 ESM 固件不匹配的问题。

注：只有将 ESM 固件文件成功下载到存储扩展箱中的 ESM 后，才能执行 ESM 固件
自动同步。

图 29. Download Environmental (ESM) Card Firmware 窗口
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要启用 ESM 固件自动同步，请确保您的系统满足以下要求：

v Storage Manager Event Monitor 已安装并处于运行状态。

v 在 Storage Manager Client（SMclient）Enterprise Management 窗口中定义 DS3000 存
储子系统。

下载驱动器固件
本部分提供下载 DS3000 驱动器固件的指示信息。要获取更多信息，请参阅联机帮助。

要点：开始下载驱动器固件之前，请完成以下任务：

v 在向 DS3000 存储子系统下载驱动器固件之前，停止所有 I/O 活动。

v 对于访问要升级固件的驱动器的所有逻辑驱动器，卸装它们的文件系统。

v 为您选择进行固件升级的驱动器执行所有数据的完全备份。

要下载驱动器固件，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Support → Download firmware → Download Drive Firmware。这时将
打开 Download Drive Firmware 窗口。

3. 单击 Add 找到包含待下载固件的服务器目录。

4. 选择要下载的固件文件并单击 OK。该文件随后将列入 Selected Packages 区域
中。

5. 为任何其他驱动器类型选择要下载的固件文件，然后单击 OK。其他文件随后也会
列入 Selected Packages 区域中。最多可选择四种驱动器类型。

6. 单击 Add 重复步骤 5，直至您已选择了要下载的所有固件文件。

7. 指定要下载的固件软件包后，单击 Next。

8. 在 Select Drive 窗口（如第 87页的图 31 所示）中，单击 Compatible Drives 选
项卡。Compatible Drives 页面包含一个驱动器列表，这些驱动器与您选择的固件软

图 30. Download Drive Firmware 窗口
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件包类型兼容。用鼠标依次选择多个驱动器时按住 Ctrl 键，或用鼠标选择系列中列
出的多个驱动器时按住 Shift 键。将您在步骤 第 86页的4 和 第 86页的5 中选择
的兼容固件下载到选定的驱动器。

注：Compatible Drives 页面中应列出您选择下载的固件软件包。如果您的驱动器产
品标识与固件类型匹配，但页面中并未将它作为兼容固件列出，请与您的技
术支持代表联系以获取更多指示信息。

9. 单击 Finish 开始将驱动器固件下载到您在步骤 第 86页的 8 中选择的各个兼容驱
动器。

10. 当显示 Download Drive Firmware 警告窗口和消息 Do you want to continue? 时，
请输入 yes 并单击 OK 开始下载驱动器固件。这时将打开 Download Progress 窗
口，如第 88页的图 32 所示。在下载过程完成之前，请勿干预下载。

图 31. Select Drive 窗口
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计划下载固件的各个驱动器将标为 in progress，直至其状态变为 successful 或
failed。

11. 如果驱动器下载失败，请完成以下步骤：

a. 单击 Save as 按钮保存错误日志。

b. 在 Subsystem Management 窗口中，单击 Support → View Event Log 并完
成以下步骤以保存存储子系统事件日志，然后与您的技术支持代表联系：

1) 单击 Select all。

2) 单击 Save as。

3) 提供用于保存日志的文件名。

Close 按钮激活时，表明驱动器固件下载过程已完成。

12. 单击 Close。

阵列导入和导出功能
阵列导入和导出功能实现了多个 DS3000 存储子系统之间的配置转移。

要点：阵列导入和导出功能仅适用于运行控制器固件版本 07.35 或更高版本的 DS3000

存储子系统。该功能不适用于使用控制器固件版本 06.xx 的存储子系统或阵列。

导出阵列
要导出阵列，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Advanced Support 选项卡。

2. 单击 Export Array。这时将启动 Export Array 向导。该向导将帮助您准备将阵列
从一个存储子系统导出到另一个存储子系统。

要点：在启动导出功能前，必须停止针对导出阵列的所有 I/O 操作。

图 32. Download Progress 窗口
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3. 选择要导出的阵列，然后单击 Next。

图 33. 在 Export Array 向导中选择阵列
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4. 这将打开 Preparation Checklist 窗口，并提供在能够导出阵列之前必须完成的一系列
步骤。

5. 在完成这个准备核对表之后，单击 Finish。

6. 在 Confirm Export 窗口，输入 yes，开始导入操作过程，然后单击 OK。

7. 在导出操作完成之后，可以从存储子系统中卸下硬盘驱动器。

导入阵列
要导入阵列，请完成以下步骤：

1. 插入硬盘驱动器，这个硬盘驱动器与存储子系统中已导出的阵列有关。

2. 在 Subsystem Management 窗口中，单击 Advanced Support 选项卡。

图 34. Export Array Preparation Checklist 窗口
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3. 单击 Import Array。这会打开 Import Report 窗口，并显示正在导入的阵列的详细
信息。

4. 如果报告中的信息正确无误，那么请在 Confirm Import 窗口中输入 yes，然后单击
OK，开始导入操作过程。

执行其他存储子系统管理任务
以下列表描述可执行的其他存储子系统管理任务。您可以在 Subsystem Management 窗
口中执行以下任务。

v 创建热备用（Configure → Configure Hot Spares）

v 自动创建逻辑驱动器和热备用（Configure → Automatic Configuration）

v 编辑子系统的主机拓扑配置（Modify → Edit Topology）

v 输入或更改存储子系统密码（Tools → Set or Change Password）

v 查看或更改介质扫描设置（Tools → Change Media Scan Settings）

v 定位存储子系统或其组件（Tools → Locate）

v 查看或启用高级功能部件（Tools → View/Enable Premium Features）

v 更改存储子系统的机箱标识号（Tools → Change Enclosure ID Numbers）

v 同步控制器时钟（Tools → Synchronize Controller Clocks）

图 35. Import Report 窗口
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v 更改网络配置（Tools → Change Network Configuration）

v 重置电池寿命（Tools → Reset Battery Age）

v 继承操作系统的系统设置（Tools → Inherit System Settings）

v 查看主要事件日志（Support → View Event Log）

v 保存所有存储子系统数据（Support → Gather Support Information）

v 使控制器联机或脱机（Support → Manage Controllers）

要获取有关这些任务和其他存储子系统管理任务的更多信息，请参阅 Subsystem Man-

agement 联机帮助中的相应主题。

高级用户：您可以在 Enterprise Management 窗口中，通过单击 Tools → Script Edi-
tor 执行其他存储子系统管理任务。要获取更多信息，请参阅 Enterprise Management 窗
口联机帮助。

注：如果存储子系统出现问题，存储子系统旁的 Enterprise Management 窗口中会显示
Needs Attention 状态图标。在 Subsystem Management 窗口中，Summary 页面的
状态区会显示 Storage Subsystem Needs Attention 链接。您可以单击该链接打开
Recovery Guru 。也可以在 Subsystem Management 窗口中单击 Support → Recover
from Failure 打开 Recovery Guru 。

DS3300 的最佳实践准则
为使 Storage Manager 软件和 DS3300 达到最佳性能，请遵循以下部分中的准则。

Microsoft iSCSI Software Initiator 注意事项
DS3300 不支持 Microsoft iSCSI Software Initiator（V2.03 或更高版本）随附的本地
MPIO。您必须使用 Storage Manager 软件随附的 DSM 以确保故障转移和 I/O 访问是
正确的。如果使用 Microsoft iSCSI Software Initiator 随附的 MPIO，会产生意外结果。

iSNS 最佳实践
正确使用 iSNS 服务器有许多注意事项。确保正确分配了在发起方或目标的 DHCP 租
用发现期间提供的 iSNS 服务器地址。当使用基于发起方的软件解决方案时将简化发现
过程。如果您无法做到这一点，而且必须手动将 iSNS 服务器指定给软件或硬件发起
方，那么应该确保 DS3300 目标和 iSCSI 发起方的所有端口在同一网段中（或确保不
同网段间的路由是正确的）。如果这一点也无法实现，将无法在 iSCSI 发现过程中发现
所有端口，因此可能无法正确地进行控制器或路径故障转移。

使用 DHCP
不建议为目标门户网站使用 DHCP。如果您使用的是 DHCP，应该分配保留的 DHCP，
这样在 DS3300 存储子系统重新启动后租用仍有效。如果未提供静态的保留 IP，启动
器端口可能会丢失与 DS3300 控制器的通信，并且可能无法重新连接到设备。

使用支持的硬件发起方
本文档发布时，仅支持以下硬件发起方：

v IBM iSCSI Server TX 适配器

v IBM iSCSI Server SX 适配器
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v 用于 IBM System x 的 QLogic iSCSI 单端口 PCIe HBA

v 用于 IBM System x 的 QLogic iSCSI 双端口 PCIe HBA

所有受支持的硬件发起方都使用相同的基本固件代码和 SANsurfer 管理应用程序。在安
装和配置这些适配器之前，请确保您已安装了最新的管理应用程序和最新的固件代
码。确认此点后，每次配置一台适配器。

要确保正确执行故障转移，通过以下两种基本配置中的一种来连接每台适配器：

v 如果已进行所有适配器和目标端口都在同一网段中的简单配置，那么每个适配器都
应该能登录到任何目标端口。

v 如果已进行复杂配置，那么每个适配器都有单独的路径连接到每台控制器设备。

要从硬件发起方正确登录到所有可用的目标端口，请完成以下步骤。

注：如果未能执行以下过程中的步骤，可能导致路径故障转移不一致且 DS3300 操作不
正确。

1. 启动 SANsurfer 管理实用程序。

2. 连接到运行 qlremote 代理的系统。

3. 选择要配置的适配器。

4. 为适配器选择端口 0 或端口 1。

5. 单击 Target Settings。

6. 单击窗口最右侧的加号（+）。

7. 输入要连接的目标端口的 IPv4 或 IPv6 地址。

8. 单击确定。

9. 选择 Config Parameters。

10. 滚动到看见 ISID 为止。

11. 对于连接 0，列出的最后一个字符应该为 0。对于连接 1，应该为 1，对于连接 2，
应该为 2，以此类推。

12. 对于要创建的每个目标连接，重复步骤 6 至 11。

13. 在连接所有会话后，请选择 Save Target Settings。

如果使用用于 IBM System x 的 QLogic iSCSI 单端口或双端口 PCIe HBA 支持 IPv6，
那么应该允许主机总线适配器固件分配本地链路地址。

使用 IPv6
DS3300 支持因特网协议 V6（IPv6）TCP\IP。请注意，如果您手动分配本地链路地址，
那么仅能配置最后四个八位元。前四个八位元是 fe80:0:0:0。尝试从发起方连接到目标时
需要完整的 IPv6 地址。如果您未提供完整的 IPv6 地址，发起方可能无法连接到目标。

网络设置
在复杂网络拓扑中使用 DS3300 将产生一些问题。如果可能，请尝试将 iSCSI 流量隔
离到专门的网络。如果不可能进行隔离，应该遵循下述建议：

v 如果使用的是基于硬件的发起方，“保持激活状态”超时应该为 120 秒。要设置“保
持激活状态”超时，请完成以下步骤：

1. 启动 SANsurfer 管理实用程序并连接到服务器。
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2. 选择要配置的适配器和适配器端口。

3. 选择端口选项和固件。

缺省连接超时是 60 秒。对于简单网络拓扑而言这是正确的设置；但是，如果在较
复杂的配置中未使用快速生成树域和单独生成树域，一旦发生网络汇总您可能会
遇到 I/O 超时问题。

v 如果是使用 Linux 软件发起方连接 DS3300，请修改 ConnFailTimeout 以解决步骤 3

中描述的生成树问题。ConnFailTimeout 值应该设置为 120 秒。

操作系统注意事项
为了实现最佳性能，请勿在 Red Hat Enterprise Linux 4 和 SUSE Linux Enterprise Server

9 操作系统中使用了嵌入软件启动程序时，启用数据和头摘要。如果启用这些功能，将
降低性能，万一有多个主机同时访问同一个 DS3300 存储子系统，您可能会发现路径被
错误地标注为已失败。

SATA 磁盘驱动器的最佳实践准则
如果组合分割区大小为 8 KB，就无法在配置有 SATA 驱动器的逻辑驱动器上执行
Linux ext2 文件系统的格式化。为了实现最佳性能，请确保使用 SATA 磁盘驱动器时
的组合分割区大小至少为 32 KB。

光纤通道的最佳实践准则
如果您安装的 Linux 主机中带有 QLogic 主机总线适配器，将安装分发版随附的缺省设
备驱动程序。通过 Linux 安装过程安装的这些设备驱动程序支持 HBA 故障转移。如果
将这些设备驱动程序与 RDAC 多路径支持软件一起使用，那么可能会造成 RDAC 无法
找到所有可用的控制器路径。您必须安装解决方案中所提供的最新 HBA 设备驱动程
序，并确保在安装 MPP 故障转移驱动程序之前使用该设备驱动程序重制 RAM 磁盘映
像。如果操作失败，将导致控制器和路径故障转移错误。

如果 Novell NetWare 6.5 中使用 Emulex 4 GB 主机总线适配器，就必须在驱动程序
载入行中添加以下参数：

N_TIMEOUT=0

Storage Manager 2 Enterprise Manager 视图和 Subsystem
Management 视图的最佳实践准则

在使用 Storage Manager 2 Enterprise Management 视图和 Application Management 视
图之前，必须注意以下信息：

v 当前用于收集性能统计信息的命令（ s a v e s t o r a g e s u b y s t e m

performancestats=filename.xls;）收集不到任何有效数据。所有值都为零（0）。本文档
发布时，无任何可用的变通方法。

v 要使用 smcli 或 Enterprise Manager 脚本编辑器来创建逻辑驱动器，就必须确保命令
的语法正确。指定逻辑驱动器大小时，正确的语法如下：

create logicalDrive array[array_number] capacity=size_of_logical_drive TB/GB/MB;

注：在 TB/GB/MB 之前必须留有一个空格；否则命令不起作用。
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v Storage Manager 2 Application Management 视图仅限于创建至多 64 个 FlashCopies

和 128 个 VolumeCopies。但是使用 Storage Manager 命令行界面最多可创建 128 个
FlashCopies 和 255 个 VolumeCopies。

v 如果您正在更新 DS3000 存储子系统，第一次可能无法下载控制器固件。如果出现这
种情况，请再次启动固件下载并验证固件是否成功下载。如果固件下载仍然失败，
请联系 IBM 技术支持代表。

v 要使用 smcli 或 Enterprise Manager 脚本编辑器来扩展逻辑驱动器，就必须确保命令
的语法正确。指定逻辑驱动器大小时，正确的语法如下：

set logicalDrive[logical_drive_name]
addCapacity=size_to_increase_logical_drive_by TB/GB/MB;

注：在 TB/GB/MB 之前必须留有一个空格；否则命令不起作用。

v 将 FlashCopy 逻辑驱动器映射到连接基极逻辑驱动器的 NetWare 主机时，请完成以
下步骤：

1. 从主机中卸下基极逻辑驱动器。

2. 卸下包含基极逻辑驱动器的存储分区。

3. 断开客户机与 NetWare 主机之间的会话连接。

4. 将 FlashCopy 逻辑驱动器映射到主机。

5. 安装 FlashCopy 卷并执行所需操作。

6. 重新连接客户机和 NetWare 主机。

为了实现最佳性能并避免重复先前步骤，请始终将 FlashCopy 逻辑驱动器安装到辅助
主机。

v 如果管理客户机和管理控制器或控制器 TCP/IP 地址的主机代理之间正在使用
firewall，请确保已为 TCP/IP 端口 2463 创建独占模式。该端口用于 Storage Man-

ager 软件与管理器子系统之间的通信。

v 要将 Storage Manager 软件从先前版本升级到 Storage Manager V06.70.xx.xx，就必
须重新搜索所有存储子系统。无法维护先前的管理域。
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第 9 章 完成 Windows 主机的存储管理任务

本章提供的信息包括如何在 Windows 操作系统环境中添加或删除逻辑驱动器、使用
hot_add 和 SMdevices 实用程序、启动及停止主机代理软件以及卸载 Storage Manager

组件。

添加或删除逻辑驱动器
使用以下过程添加或删除标准（非集群）或集群配置中的逻辑驱动器。

Windows Server 2003 和 Windows Server 2008 标准（非集群）配置
使用以下过程在标准配置中创建或删除逻辑驱动器。

创建逻辑驱动器
使用 Storage Manager 软件创建逻辑驱动器时，必须将新的逻辑驱动器添加到 Win-

dows Server 2003 或 Windows Server 2008 操作系统。Windows Server 将每个逻辑驱
动器作为一个磁盘驱动器。

在您创建逻辑驱动器后，要将它们添加到 Windows Server 2003 操作系统，请完成以下
步骤：

1. 右键单击 My computer；然后单击 Manage → Device Manager → Disk Drives。

2. 单击 Actions → Scan for new or removed hardware。

在您添加逻辑驱动器后，请运行 Storage Manager 软件随附的 SMdevices 实用程序。
SMdevices 实用程序根据相关操作系统设备名识别逻辑驱动器。要获取更多信息，请参
阅第 98页的『使用 SMdevices 实用程序』和联机帮助。

注：对于 Windows Server 2008，在执行磁盘初始化之前，请确保该磁盘设备处于“联
机”状态。在“计算机管理” 窗口中，单击磁盘管理。这时在该窗口的底部将显示
磁盘设备。用鼠标右键单击要联机的磁盘设备，然后选择联机。

删除逻辑驱动器

警告： 首先必须使用 Disk Administrator 删除集群物理磁盘资源、删除操作系统分区并
取消指定盘符，然后再删除逻辑驱动器或重新设置 Storage Manager 软件中的配置。此
操作可防止注册表信息受到破坏。

使用 Storage Manager 删除逻辑驱动器之前，请完成以下步骤：

1. 使用 Disk Administrator 删除所有分区，并取消指定与逻辑驱动器关联的盘符。

2. 尽可能重新启动系统以除去配置信息。
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Windows Server 2003 和 Windows Server 2008 集群服务器配置
使用以下过程创建或删除集群服务器配置中的逻辑驱动器。

创建逻辑驱动器
要在 Windows Server 2003 或 Windows Server 2008 集群服务器环境中添加逻辑驱动
器，请完成以下步骤：

1. 使用 Storage Manager Client 程序创建阵列和逻辑驱动器，并使用存储分区将它们指
定到相应的集群主机组。

2. 使用 hot_add 实用程序将新的逻辑驱动器添加到当前拥有集群限额资源的集群节点。

3. 使用 Disk Administrator 程序创建、格式化新逻辑驱动器上的磁盘分区并为它们指定
盘符。

4. 在集群配置中的每个剩余集群节点上，使用 hot_add 实用程序将新的逻辑驱动器添
加到集群节点。

5. 在第一个集群节点中，使用新逻辑驱动器上的新磁盘分区通过 Cluster Administra-

tor 程序创建集群物理磁盘资源。

注：如果 Cluster Administrator 程序的可用磁盘列表中未显示该新磁盘，可能需要重
新启动服务器。

6. 在第一个集群节点中，使集群资源联机。

7. 使用 Cluster Administrator 程序，将新建的集群物理磁盘资源移至集群配置中的其他
节点。

8. 确保这些资源在集群配置的其他节点中联机。

删除逻辑驱动器

警告： 要防止注册表信息受到破坏，首先必须使用 Cluster Administrator 和 Disk Admin-

istrator 删除集群物理磁盘资源、删除操作系统分区并取消指定盘符，然后再删除逻辑驱
动器或重新设置 Storage Manager 软件中的配置。

使用 Storage Manager 软件删除逻辑驱动器之前，请完成以下步骤：

1. 使用 Cluster Administrator 删除拥有待删除逻辑驱动器的集群物理磁盘资源。

2. 使用 Disk Administrator 删除所有分区，并取消指定与逻辑驱动器关联的盘符。

3. 尽可能重新启动集群节点以除去配置信息。

使用 SMdevices 实用程序
SMutil 软件包含实用程序 SMdevices，您可以使用它查看与操作系统设备名关联的存储
子系统逻辑驱动器。当您要使用 Disk Administrator 创建盘符或分区时，这个实用程序
很实用。

注：SMdevices 命令在 DS3300 storage subsystem 中不可用。
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在存储子系统上创建逻辑驱动器后，要使用 SMdevices，请在连接到该存储子系统的主
机上完成以下步骤：

1. 在命令提示符中，转至 installation_directory\util 目录，其中 installation_directory 是
安装 SMutil 实用程序的目录。

缺省目录是 c:\Program Files\IBM_DS3000\util。

2. 输入以下命令：

SMdevices

该软件将显示设备标识信息。例如，您可能看到以下信息：

\\.\PHYSICALDRIVEx [Storage Subsystem finance, Logical Drive debit,
LUN xx, WWN worldwide_name]

其中：

v x 是“磁盘管理员”中显示的磁盘编号

v finance 是存储子系统的名称

v debit 是逻辑驱动器的名称

v xx 是与逻辑驱动器相关联的 LUN

v worldwide_name 是逻辑驱动器的通用名称

使用 SMrepassist 实用程序
您可以使用 SMrepassist 实用程序清空逻辑驱动器已高速缓存的数据。

要点：在 Windows Server 2003 或 NetWare 环境中，FlashCopy 驱动器不能添加或映
射到拥有 FlashCopy 逻辑驱动器的基本逻辑驱动器的同一台服务器。您必须将 FlashCopy

逻辑驱动器映射到另一台服务器。

要清空逻辑驱动器中已高速缓存的数据，请完成以下步骤：

1. 在命令提示符中，转至 installation_directory\util 目录，其中 installation_directory 是
安装 SMutil 实用程序的目录。

缺省目录是 c:\Program Files\IBM_DS3000\util。

2. 输入以下命令：

smrepassist -f logical_drive_letter

其中 logical_drive_letter 是指定到逻辑驱动器中已创建磁盘分区的操作系统盘符。

停止并重新启动主机代理软件
如果要将存储子系统添加到主机代理软件的管理域，必须停止并重新启动主机代理软
件。重新启动服务时，主机代理软件会发现新的存储子系统并将它们添加到管理域。

注：如果重新启动后未检测到任何访问逻辑驱动器，主机代理软件将自动停止运行。
确保主机与 DS3300 或 DS3400 存储子系统连接的 SAN 之间的光纤通道或 iSCSI

连接状态正常。然后重新启动主机或集群节点，以发现新的主机代理管理存储子
系统。

要停止并重新启动 Windows Server 2003 的主机代理软件，请完成以下步骤：
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1. 单击开始 → 管理工具 → 服务。这时将打开“服务”窗口。

2. 右键单击 IBM DS3000 Storage Manager 2 Agent。

3. 单击重新启动。IBM DS3000 Storage Manager 2 Agent 将停止，然后再次启动。

4. 关闭“服务”窗口。

卸载存储管理软件组件
使用以下过程卸载 Storage Manager 2 软件的一个或多个组件。软件删除过程中将保留
现有存储阵列映射和存储分区配置，并且新的客户端软件可识别它们。

要点：除非您的技术支持代表要求您卸载 MPIO 设备驱动程序，否则不要卸载它。主机
代理软件包需要 MPIO 才能正常运行。

要卸载 Storage Manager 2 软件，请完成以下步骤：

1. 单击开始 → 设置 → 控制面板。这时将打开“控制面板”窗口。

2. 选择添加或删除程序。这时将打开“添加或删除程序”窗口。

3. 选择 IBM DS3000 Storage Manager Host Software 02xx.x5.yy，其中 xx 是主
发行版（例如，17），yy 是版本（例如，01）。

4. 单击更改/删除。将启动卸载程序。

5. 单击 Next。这时将打开 Uninstall options 窗口。

6. 选择卸载所有已安装的 DS3000 主机软件包或仅卸载特定软件包，然后单击 Next。
如果选择卸载所有主机软件包，程序将开始卸载所有已安装的主机软件包。

7. 如果选择卸载特定主机软件包，请选择要卸载的主机软件包并单击 Uninstall。

8. 单击 Done 完成 DS3000 主机软件卸载过程。如果卸载 MPIO，必须重新启动主机
服务器。
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第 10 章 启用和使用高级功能部件

高级功能部件提供一些增强功能，您可以使用这些功能执行使用基本型号的存储子系
统执行时受限制或无法执行的任务。

您可以购买 DS3000 存储子系统的以下高级功能部件：

v DS3000 FlashCopy 扩展许可证

v DS3000 卷拷贝许可证

v DS3000 FlashCopy 卷拷贝许可证

v DS3000 分区扩展许可证

要获取有关如何购买高级功能部件的信息，请与您的 IBM 销售代表或授权经销商联系。

获取激活密钥文件并启用高级功能部件
请按照您的高级功能部件随附的《激活指示信息》文档操作以获取激活密钥文件。Stor-

age Manager 软件需要激活密钥文件才能启用高级功能部件。

启用 DS3000 分区扩展许可证
您可以升级 DS3000 分区扩展许可证，将存储子系统从 4 个分区升级至 16 个分区。
获得 DS3000 分区扩展许可证密钥后，请完成以下步骤启用 Storage Manager 软件中的
此功能部件：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Enabled Premium Features 下，单击 Upgrade a feature，如第 102页的图
36 所示。

© Copyright IBM Corp. 2006, 2008 101



这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

4. 在 Enable Premium Feature 窗口中单击 Yes。

启用 DS3000 FlashCopy 扩展许可证
获得 DS3000 FlashCopy 扩展许可证密钥后，请完成以下步骤启用 Storage Manager 软
件中的此功能部件：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Disabled Premium Features 下，单击 Enable a feature，如图 36 所示。
这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

4. 在 Enable Premium Feature 窗口中单击 Yes。

启用 DS3000 VolumeCopy 许可证

注：本文档、Storage Manager Client 程序界面和联机帮助中使用的术语 VolumeCopy 和
逻辑驱动器复制可以互换。

要启用 DS3000 VolumeCopy 许可证，请完成以下步骤：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Disabled Premium Features 下，单击 Enable a feature，如图 36 所示。
这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

图 36. View/Enable Premium Features 窗口

102 DS3000 Storage Manager Windows、Linux、NetWare 和 VMware 版安装和支持指南



4. 在 Enable Premium Feature 窗口中单击 Yes。

使用 FlashCopy 高级功能部件
FlashCopy 逻辑驱动器是称为“基本逻辑驱动器”的逻辑驱动器的逻辑时间点映像。
FlashCopy 逻辑驱动器具有以下特征：

v 可快速创建，并且所需磁盘空间比实际逻辑驱动器少。

v 可以为它指定主机地址，这样您可以在基本逻辑驱动器联机并可访问时使用 FlashCopy

逻辑驱动器执行备份操作。

v 可以使用 FlashCopy 逻辑驱动器执行应用程序测试或方案开发和分析。这并不影响实
际生产环境。

v 允许的最大 FlashCopy 逻辑驱动器数是控制器型号支持的逻辑驱动器总数的一半。

要获取有关 FlashCopy 功能部件以及如何管理 FlashCopy 逻辑驱动器的更多信息，请
参阅子系统管理联机帮助。

要点：在 Windows Server 2003 或 NetWare 环境中，FlashCopy 驱动器不能添加或映
射到拥有 FlashCopy 逻辑驱动器的基本逻辑驱动器的同一台服务器。您必须将 FlashCopy

逻辑驱动器映射到另一台服务器。

要创建 FlashCopy 逻辑驱动器，请完成以下步骤：

1. 为确保您具有基本逻辑驱动器的正确时间点映像，请停止应用程序并清空基本逻辑
驱动器的高速缓存 I/O。

2. 打开 Subsystem Management 窗口，单击 Configure → Create FlashCopy Logi-
cal Drive，并按照向导中的指示信息操作。

3. 要获取将 FlashCopy 逻辑驱动器添加到主机的指示信息，请参阅子系统管理联机帮
助。

注：要管理已创建的 FlashCopy 逻辑驱动器，请单击 Modify 选项卡并选择 Modify
FlashCopy Logical Drives。选择 Disable FlashCopy Logical Drives、Re-
create FlashCopy Logical Drives 或 Expand the FlashCopy Repository，
然后按照向导中的指示信息操作。

使用 VolumeCopy
VolumeCopy 功能部件是一个基于固件的机制，用于在存储器阵列中复制逻辑驱动器数
据。这个功能部件设计为一个系统管理工具，用于执行将数据转移到其他驱动器以实
现硬件升级、性能管理、数据备份或快照卷数据复原等任务。您可以通过指定两个兼
容的驱动器来提交 VolumeCopy 请求。一个驱动器指定为源驱动器，另一个则指定为目
标驱动器。VolumeCopy 请求为持久请求，因此复制进程的所有相关结果都会传递给您。

要获取有关 VolumeCopy 功能部件以及如何管理 VolumeCopy 逻辑驱动器的更多信息，
请参阅子系统管理联机帮助。

要创建 VolumeCopy，请打开 Subsystem Management 窗口，单击 Configure → Cre-
ate Volume Copy，并按照向导中的指示信息操作。

注：要管理已创建的 VolumeCopy 逻辑驱动器，请单击 Modify → Manage Logical
Drive Copies。将显示 VolumeCopy 请求的列表。对于每个 VolumeCopy，请选
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择 Re-Copy 或 Stop，如果要修改属性，请选择 Permissions 和 Priority。图
37 显示了该工具。

图 37. Manage Logical Drive Copies 窗口
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附录 A. 存储子系统和控制器信息记录

表 12 提供一个数据表，用于记录存储子系统名称、管理类型、以太网硬件地址和 IP 地
址。将此表复印一份并填入您的存储子系统和控制器信息。使用这些信息来设置网络
服务器和主机的 BOOTP 表或域名系统（DNS）表。如果在首次安装后添加存储子系
统，这些信息也很实用。每个列标题包含一个页码索引，它指向获取信息的详细指示
信息。信息记录样本请参阅第 25页的表 11。

表 12. 存储子系统和控制器信息记录

存储子系统名称
（第 24 页）

管理方法（第 7
页）

控制器：以太网和 IP 地址、主机名（第 24 和
25 页）

主机：IP 地址和主机名（第
25 页）
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附录 B. 使用 IBM System Storage DS3000 控制器固件升级工
具

要点：
仅在将 DS3000 控制器从版本 06.22 或 06.24 迁移至版本 07.35 时，使用 IBM

System Storage DS3000 控制器固件升级工具。

请勿使用控制器固件升级工具进行控制器、ESM、或硬盘驱动器固件的标准升
级。要进行 DS3000 控制器、EXP3000 ESM 或硬盘驱动器的标准升级，请参阅
第 83页的『下载控制器、NVSRAM、ESM 和硬盘驱动器固件』。

概述
警告： 为了防止数据丢失，在使用控制器固件升级工具从固件版本 06.22 或 06.24 迁
移至版本 07.35 之前，必须备份所有数据并保存现有系统配置。一旦升级工具完成固件
升级后，DS3000 控制器就无法恢复到先前的固件版本。

使用升级工具之前，请阅读以下重要信息：

v 进行脱机升级。

v 在现有主机环境中，以联机方式执行 Storage Manager 软件的完整安装过程。

v 为使多数故障转移驱动程序生效，重新启动主机。

v 下载固件之前，请确保所有设备都处于 Optimal 状态。

v 检查当前固件级别，确保固件级别为 06.22.xx.xx 或 06.24.xx.xx。固件升级工具仅支
持从固件版本 06.22.xx.xx 或 06.24.xx.xx 升级至 07.xx。

警告： 为了避免可能出现的数据访问丢失，请查看 Storage Manager 自述文件，确保
所下载的固件与安装在存储子系统上的 Storage Manager 软件相兼容。如果下载了不兼
容的固件，那么可能会丢失对存储子系统中驱动器的访问，因此请先升级 Storage Man-

ager 软件。在升级期间，不要更改配置或卸下任何驱动器或机柜。

检查存储子系统运行状况
为了确定存储子系统的运行状况，请完成以下步骤：

1. 在 Storage Manager 软件的 Array Management 窗口中，用鼠标右键单击存储子系
统。Storage Manager 软件与每个受管设备建立了通信，并确定了当前状态。共有 6

种可能的状态：

Optimal
存储子系统中的所有组件都达到了您所希望的工作状态。

Needs Attention
存储子系统存在问题，需要进行纠正。

Fixing 纠正了一个 Needs Attention 情况，目前正在变为 Optimal 状态。

Unresponsive
管理站无法与存储子系统中的（一个或两个）控制器进行通信。
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Contacting Device
Storage Manager 软件正在建立与存储子系统的联系。

Needs Upgrade
存储子系统所运行的某个级别的固件不再受 Storage Manager 软件的支持。

2. 如果状态为 Needs Attention，请记下这种情况。然后，请与您的 IBM 技术支持代
表联系，了解故障解决方法。

注：Storage Manager 软件中的 Recovery Guru 还提供了对各种情况的详细说明和恢
复过程。

安装控制器固件升级工具
要安装控制器固件升级工具，请完成以下步骤：

1. 根据具体的操作系统过程，打开 DS3000 Storage Manager 10 安装文件。在安装 Stor-

age Manager 10 过程中，会安装 IBM System Storage DS3000 控制器固件升级工
具。

2. 单击 Next。

3. 接受许可证协议，然后单击 Next。

4. 选择这个工具的安装文件夹，然后单击 Next。

5. 单击 Install。

6. 单击 Done。

添加存储子系统
要使用升级工具添加存储子系统，请完成以下步骤：

1. 单击 Add。这时将打开 Select Addition Method 窗口。

2. 选择 Automatic 或 Manual。

3. 单击 OK，开始添加存储子系统。

4. 要查看在添加存储子系统过程中出现的任何可能阻碍固件升级的问题，请单击 View
Log。

下载固件
要下载固件，请完成以下步骤：

1. 选择要下载固件的存储子系统，然后单击 Download Firmware。这时将打开 Down-

load Firmware 窗口。

2. 要选择希望从您的计算机或网络上的某个目录下载的控制器固件文件，请单击
Browse。

3. 要选择希望从您的计算机或网络上的某个目录下载的 NVSRAM 文件，请单击
Browse。

4. 单击 OK。开始下载固件。 Controller Firmware Upgrade 窗口将显示一个状态栏。

在完成固件文件的下载之后，开始激活固件，控制器固件升级工具的状态栏中将显示
状态 Activating。
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注：固件激活过程至多需要 30 分钟。如果 30 分钟后，Activating 状态消息未变化，
那么请使用 Storage Manager 10 软件来检查控制器概要文件数据，从而确定固件
下载是否成功完成。

查看控制器固件升级工具日志文件
如果在更新控制器固件期间遇到任何问题，请完成下列步骤来查看控制器固件升级工
具日志文件：

1. 单击 View Log。这时将打开 View Log 窗口。该日志记录了存储子系统所出现的
可能阻碍固件更新的任何问题。

2. 如果日志中记录了问题，那么在尝试下载固件之前，请先纠正这些问题。
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附录 C. 辅助功能选项

本部分提供备用键盘导航的相关信息，这是 DS3000 Storage Manager 软件的一个辅助
功能选项。辅助功能选项可以帮助有生理残障（如行动不便或视力不佳）的用户正常
使用软件产品。

使用本部分描述的备用键盘操作，您可以使用键或组合键执行 Storage Manager 任务，
以及执行鼠标也可以完成的许多菜单操作。

除了本部分描述的键盘操作外，DS3000 Storage Manager 2 软件 Windows 安装包还包
含一个屏幕朗读器软件界面。要启用屏幕朗读器，请在 Windows 主机或管理站上使用
安装向导安装 Storage Manager 2 软件时选择 Custom Installation。然后，在 Select

Product Features 窗口中选择 Java Access Bridge 以及其他必需的主机软件组件。

帮助查看器窗口的窗格中有时可能无法清晰显示键盘焦点。如果看不清键盘焦点的位
置，请按 Ctrl+F1。如果焦点在工具栏中的 Back、Forward、Print 或 Page Setup 按钮
上，将显示相应按钮的备用文本。如果未显示备用文本，表示键盘焦点不在按钮上。
按 Ctrl+Tab 查看焦点是否在某个导航器选项卡上（Contents 选项卡、Index 选项卡
或 Search 选项卡）。如果焦点在某个导航选项卡上，请按 Shift+Tab 将焦点切换到工
具栏窗格。

表 13 定义可用于浏览、选择或激活用户界面组件的键盘操作。此表中使用以下术语：

v 浏览表示将输入焦点从一个用户界面组件移至另一个。

v 选择表示选择一个或多个组件，通常之后将进行操作。

v 激活表示执行组件操作。

组件之间的导航通常需要使用以下键：

v Tab：将键盘焦点移至下一个组件或下一组组件中的第一个组件

v Shift+Tab：将键盘焦点移至上一个组件或上一组组件中的第一个组件

v 方向键：将键盘焦点在一组组件中的各组件之间移动

表 13. DS3000 Storage Manager 软件的备用键盘操作

快捷键 操作

F1 打开帮助。

F10 将键盘焦点移至主菜单栏并显示第一个菜单；使用方向键
浏览可用选项。

Alt+F4 关闭管理窗口。

Alt+F6 在窗口（非模态）和管理窗口之间移动键盘焦点。

Alt+underlined_letter 使用加下划线的字母的相关键访问菜单项、按钮和其他界
面组件。

对于菜单选项，可按 Alt+ 加下划线的字母访问主菜单，然
后按加下划线的字母访问个别菜单项。

对于其他界面组件，可按 Alt+ 加下划线的字母。

Ctrl+F1 当键盘焦点在工具栏上时，显示或隐藏工具提示。

空格键 选择某项或激活某个超链接。
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表 13. DS3000 Storage Manager 软件的备用键盘操作 (续)

快捷键 操作

End、Page Down 将键盘焦点移至列表中的最后一项。

Esc 关闭当前窗口（不需要键盘焦点）。

Home、Page Up 将键盘焦点移至列表中的第一项。

Shift+Tab 在各组件之间反向移动键盘焦点。

Ctrl+Tab 将键盘焦点从一个表移至下一个用户界面组件。

Tab 在各组件之间浏览键盘焦点或选择超链接。

向下箭头 在列表中将键盘焦点向下移动一项。

向左箭头 向左移动键盘焦点。

向右箭头 向右移动键盘焦点。

向上箭头 在列表中将键盘焦点向上移动一项。
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附录 D. 获取帮助和技术协助

如果您需要帮助、服务或技术协助，或者仅希望了解有关 IBM 产品的更多信息，则可
从 IBM 找到各种可用的资源来帮助您。本节包含以下信息：到何处寻找有关 IBM 和
IBM 产品的更多信息，在系统出问题时该采取哪些措施，以及在需要时向谁请求服务。

请求服务之前
在您请求服务之前，请确保已经采取了以下步骤来尝试自行解决问题：

v 检查所有电缆以确保它们都已连接。

v 检查电源开关以确保系统和任何可选设备已经开启。

v 使用系统文档中的故障诊断信息，并使用系统随付的诊断工具。有关诊断工具的信
息位于系统随附的 IBM 文档 CD 上的《问题确定与维护指南》中。

v 请转至 IBM 支持 Web 站点 http://www.ibm.com/systems/support/ 查看技术信息、技
巧、提示和新的设备驱动程序或提交请求以获取信息。

按照 IBM 在联机帮助或 IBM 产品随附的文档中所提供的故障诊断过程，您无需外界
帮助即可解决许多问题。IBM 系统随附的文档还描述了您可以执行的诊断测试。大多数
系统、操作系统和程序都随附包含故障诊断过程及错误消息和错误代码说明的文档。
如果您怀疑软件有问题，请参阅操作系统或程序的文档。

使用文档
有关 IBM 系统和预安装软件（如果有）或可选设备的信息可从产品随附的文档中获得。
此类文档可能包括印刷文档、联机文档、自述文件和帮助文件。有关使用诊断程序的
说明，请参阅您的系统文档中的故障诊断信息。故障诊断信息或诊断程序可能会告诉
您需要其他或更新的设备驱动程序或其他软件。IBM 对您可以获取最新的技术信息并下
载设备驱动程序及更新的万维网页面进行维护。要访问这些页面，请转至 http://

www.ibm.com/systems/support/ 并按照指示信息进行操作。另外，某些文档可以通过位于
http://www.ibm.com/shop/publications/order/ 上的 IBM Publications Center 获得。

从万维网获取帮助和信息
在万维网上，IBM Web 站点提供关于 IBM 系统、可选设备、服务和支持的最新信息。
有关 IBM System x™ 和 xSeries® 的信息位于 http://www.ibm.com/systems/x/。有关 IBM

BladeCenter® 的信息位于 http://www.ibm.com/systems/bladecenter/。IBM IntelliStation® 信
息的地址是 http://www.ibm.com/intellistation/cn。

您可以在 http://www.ibm.com/systems/support/ 找到有关 IBM 系统和可选设备的服务信
息。

软件服务和支持
通过 IBM 支持热线，您可以获得付费电话协助，内容涉及 System x 和 xSeries 服务
器、BladeCenter 产品、IntelliStation 工作站和设备的使用、配置以及软件问题。有关您
所在国家或地区支持热线支持哪些产品的信息，请访问 http://www.ibm.com/support/

cn/。
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有关支持热线和其他 IBM 服务中心的更多信息，请访问 http://www.ibm.com/

support/cn 或 http://www.ibm.com/planetwide/cn 以获取支持电话号码。在中国，请拨打
免费咨询热线 800-810-1818 转 5300 或 010-84981188 转 5300 查询相关信息。

硬件服务和支持
您可通过 IBM 经销商或服务中心获得硬件服务。要查找 IBM 授权经销商提供的保修
服务，请访问 http://www.ibm.com/partnerworld/ ，然后单击页面右边的 Find a Busi-
ness Partner。要获取 IBM 支持电话号码，请参阅 http://www.ibm.com/planetwide/。
在中国，请拨打免费咨询热线 800-810-1818 转 5300 或 010-84981188 转 5300 查询
相关信息。

在中国，硬件服务和支持一般为每周 5 天，每天上午 8:30 至下午 5:30（国家法定节
假日除外）。为获得电话技术支持，客户需要首先拨打 IBM 技术支持电话；在 IBM 技
术人员通过电话进行故障诊断后认为必要时，IBM 将根据与您签署的服务协议的条款安
排您系统的维修事宜。

IBM 台湾产品服务

IBM 台湾产品服务联系信息：
IBM Taiwan Corporation

中国台湾台北市
松仁路 7 号 3 楼
电话：0800-016-888
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附录 E. 声明

本信息是为在美国提供的产品和服务编写的。

在其他国家或地区，IBM 可能不提供本文档中所讨论的产品、服务或功能。有关您目前
所在国家或地区的产品和服务的信息，请向您当地的 IBM 代表咨询。任何对 IBM 产
品、程序或服务的引用并非意在明示或默示只能使用 IBM 的产品、程序或服务。只要
不侵犯 IBM 的知识产权，任何同等功能的产品、程序或服务，都可以代替 IBM 产品、
程序或服务。但是，评估和验证任何非 IBM 产品、程序或服务的运行，由用户自行负
责。

IBM 公司可能已拥有或正在申请与本文档内容有关的各项专利。提供本文档并未授予用
户使用这些专利的任何许可。您可以用书面方式将许可查询寄往：

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

International Business Machines Corporation“按现状”提供本出版物，不附有任何种类
的（无论是明示的还是默示的）保证，包括但不限于默示的有关非侵权、适销和适用
于某种特定用途的保证。某些国家或地区在某些交易中不允许免除明示或默示的保
证。因此本条款可能不适用于您。

本信息中可能包含技术方面不够准确的地方或印刷错误。此处的信息将定期更改；这
些更改将编入本资料的新版本中。IBM 可以随时对本资料中描述的产品和/或程序进行改
进和/或更改，而不另行通知。

本信息中对非 IBM Web 站点的任何引用都只是为了方便起见才提供的，不以任何方式
充当对那些 Web 站点的保证。那些 Web 站点中的资料不是 IBM 产品资料的一部分，
使用那些 Web 站点带来的风险将由您自行承担。

IBM 可以按它认为适当的任何方式使用或分发您所提供的任何信息而无须对您承担任何
责任。

商标
IBM、IBM 徽标和 ibm.com 是 International Business Machines Corporation 在美国和/

或其他国家或地区的商标或注册商标。这些术语和其他 IBM 已注册为商标的术语在本
资料中首次出现时都使用商标符号（® 或 ™）加以标记，表示在本资料发布时由 IBM 拥
有这些根据美国联邦法律注册或普通法注册的商标。这些商标也可能是在其他国家或
地区的注册商标或普通法商标。可从“Copyright and trademark information”（http://

www.ibm.com/legal/copytrade.shtml）中获取 IBM 商标的最新列表。

Adobe 和 PostScript 是 Adobe Systems Incorporated 在美国和/或其他国家或地区的商
标或注册商标。

Cell Broadband Engine 是 Sony Computer Entertainment, Inc. 在美国和/或其他国家或
地区的商标，因此经许可后方可使用。
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Intel、Intel Xeon、Itanium 和 Pentium 是 Intel Corporation 或其分支机构在美国和其他
国家或地区的商标或注册商标。

Java 和所有基于 Java 的商标是 Sun Microsystems,Inc. 在美国和/或其他国家或地区的
商标。

Linux 是 Linus Torvalds 在美国和/或其他国家或地区的注册商标。

Microsoft、Windows 和 Windows NT 是 Microsoft Corporation 在美国和/或其他国家
或地区的商标。

UNIX 是 The Open Group 在美国和其他国家或地区的注册商标。

其他公司、产品或服务名称可能是其他公司的商标或服务标记。

重要注意事项
当提到硬盘驱动器容量或通信量时，MB 代表 1 000 000 字节，而 GB 代表
1 000 000 000 字节。用户可访问的总容量可随操作环境而变化。

内置硬盘驱动器的最大容量是指用 IBM 提供的当前支持的最大容量驱动器来替换任何
标准硬盘驱动器，并装满所有硬盘驱动器托架时的容量。

IBM 对于符合 ServerProven 认证的非 IBM 的产品或服务不作任何陈述或保证，包括
但不限于对适销和适用于某种特定用途的默示保证。这些产品由第三方提供和单独保
证。

IBM 对于非 IBM 产品不作任何陈述或保证。对于非 IBM 产品的支持（如有）由第三
方提供，而非 IBM。

某些软件可能与其零售版本（如果存在）不同，并且可能不包含用户手册或所有程序
功能。
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安装
集群服务器环境中的硬件 39

集群服务器环境中的 Windows 软件 39

集群服务器配置 18

软件
集群环境 41

新安装过程 31

在标准 Windows 配置中 31

在 NetWare 配置中 55

Linux 47

Linux 版 45

Linux MPP 软件包 48

RDAC 软件包 49

SMclient 34

软件组件
管理站 15

配置类型 17

主机服务器 15

Storage Manager 软件 31

安装准备
Linux 版 22

NetWare 版 22

Windows 版 21

安装, 完成 65

安装, 准备网络
直接管理存储子系统 23

主机管理存储子系统 24

［Ｂ］
帮助, 获取 113

标准（非集群）配置
样本配置 17

Windows Server 2003

创建逻辑驱动器 97

删除逻辑驱动器 97

并发固件下载 83

［Ｃ］
操作系统

Linux 要求 6

NetWare 要求 7

Windows 要求 5

查看样本网络 14

持久命名 52

重命名存储子系统 69

重要注意事项 2

创建
逻辑驱动器（标准 Windows 配置） 97

逻辑驱动器（Windows 集群服务器配置） 98

阵列和逻辑驱动器 73

磁盘空间要求 6

从 Web 获取文档 1

存储子系统
创建概要文件 73

发现主机代理管理 99

管理方法 7

集群服务器配置中 41

记录名称 24

命名 24, 69

确定固件级别 81

使用 VMware ESX Server 配置 58

信息记录 105

硬件要求 4

执行发现 66

执行管理任务 91

［Ｄ］
电话号码 114

定义控制器 TCP/IP 地址 12

定义主机组 73

多路径 I/O（MPIO）
磁盘空间要求 5

概述 33

［Ｆ］
访问逻辑驱动器
直接管理（频带外）中不需要 11

访问逻辑驱动器, 重新启动主机后检测 99

分区 16

分区扩展
概述 3

启用（高级功能部件） 101

辅助功能选项, Storage Manager 软件 111

［Ｇ］
高级功能部件
概述 2

获取激活密钥文件 101

启用分区扩展许可证 101

启用 FlashCopy 扩展许可证 102

启用 VolumeCopy 许可证 102
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高级功能部件 (续)

使用 FlashCopy 103

使用 VolumeCopy 103

固件级别, 确定 81

固件, 下载
控制器或 NVSRAM 84

驱动器 86

ESM 85

固件, ESM, 自动同步 33

管理方法
存储子系统 7

直接 11

主机代理（频带内） 9

管理站
概述 4

软件安装 15

硬件要求 4

Linux 组件 46

Storage Manager 软件安装 31

VMware ESX Server 58

光纤通道交换机环境, 连接主机总线适配器 16

光纤通道诊断程序 2

光纤网分区 16

规划安装
Linux 22

NetWare 22

Windows 21

［Ｈ］
获取帮助 113

［Ｊ］
激活密钥文件, 获取（高级功能部件） 101

集群服务器配置
安装硬件 39

安装 Windows 软件 39

存储子系统 41

样本网络 18

硬件配置选项 39

主机总线适配器 40

Windows Server 2003

创建逻辑驱动器 98

删除逻辑驱动器 98

记录存储子系统名称 24

简单网络管理协议（SNMP）陷阱 14

将 LUN 映射到分区 76

将 LUN 映射到分区（VMware ESX Server） 59

警报通知, 设置 70

［Ｋ］
控制器
下载固件 84

信息记录 105

［Ｌ］
临时安装文件, 在 Linux 中除去 53

逻辑驱动器
创建（标准 Windows 配置） 97

创建（Windows 集群服务器配置） 98

概述 73

删除（标准 Windows 配置） 97

删除（Windows 集群服务器配置） 98

使用可用或未配置容量创建 73

支持的 18

［Ｍ］
命名存储子系统 24, 69

［Ｎ］
内核更新 52

［Ｐ］
配置类型
标准（非集群）配置示例 17

集群服务器配置示例 18

配置主机访问 72

频带内（主机代理）管理方法
概述 9

实施任务 10

频带外（直接）管理方法
定义控制器 TCP/IP 地址 12

概述 11

建立连接 25

实施任务 13

［Ｑ］
启动 Subsystem Management 69

驱动程序, Linux MPP 50

驱动器固件
确定固件级别 81

下载 86

［Ｒ］
冗余磁盘阵列控制器（RDAC） 48, 49
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软件
安装
使用安装向导（Linux） 47

组件安装位置 15

软件服务和支持 113

软件要求
VMware ESX Server 58

软件, 安装
集群环境 41

新安装过程 31

在标准 Windows 配置中 31

在 NetWare 配置中 55

Linux 概述 45

LSIMPE 设备驱动程序 56

SMclient 34

［Ｓ］
删除
逻辑驱动器（标准 Windows 配置） 97

逻辑驱动器（Windows 集群服务器配置） 98

映射的逻辑驱动器（LUN） 53

商标 115

设备驱动程序
安装 Linux 版 HBA 45

安装 NetWare 版 HBA 55

安装 Windows 版 HBA 32

安装 Windows 版 HBA（集群服务器） 41

设置
警报通知 70

主机或 DNS 表（Linux） 30

主机或 DNS 表（Windows） 28

声明 115

声明和注意事项 2

使用
SMdevices 实用程序 98

SMrepassist 实用程序 99

数据表 105

［Ｔ］
添加
存储子系统 69

逻辑驱动器（标准 Windows 配置） 97

逻辑驱动器（Windows 集群服务器配置） 98

映射的逻辑驱动器（LUN） 53

停止并重新启动主机代理软件 99

通用 Xport 设备 9, 19

［Ｗ］
网络安装, 准备
直接管理存储子系统 23

主机管理存储子系统 24

文档, 从 Web 获取 1

［Ｘ］
系统要求
硬件 4

Linux 6

NetWare 7

Windows 5

下载固件
控制器或 NVSRAM 84

驱动器 86

ESM 85

协助, 获取 113

卸载 Storage Manager 软件
Linux 53

Windows 100

信息记录
记录存储子系统和主机信息 105

记录存储子系统名称 24

［Ｙ］
样本网络, 查看 14

要求
磁盘空间 6

软件 6

硬件 4

Windows 5

硬件
要求 4

以太网地址 23

硬件服务和支持 114

映射的逻辑驱动器, 添加及删除 53

［Ｚ］
诊断程序, 光纤通道 2

阵列, 创建 73

支持, Web 站点 113

指定 IP 地址 25

直接（频带外）管理方法
定义控制器 TCP/IP 地址 12

概述 11

缺点 11

实施任务 13

网络安装概述 23
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直接（频带外）管理方法 (续)

优点 11

主机
VMware ESX Server 58

主机表
安装前任务 23

为 Linux 设置 30

为 Windows 设置 28

主机代理（频带内）管理方法
概述 9

缺点 9

实施任务 10

网络安装概述 24

优点 9

主机代理软件, 停止并重新启动 99

主机访问, 配置 72

主机服务器
概述 4, 15

Linux 组件 46

Storage Manager 软件安装 31

主机总线适配器
安装 Linux 设备驱动程序 45

安装 NetWare 设备驱动程序 55

安装 Storport miniport 设备驱动程序 32, 41

集群服务器配置中 40

在光纤通道交换机环境中连接 16

主机组, 定义 73

注 2

注意事项 2

注意事项和声明 2

注意事项, 重要 116

准备网络安装 23

自动存储子系统发现 66

自动主机发现 66

B
BOOTP 服务器
样本网络 14

BOOTP 兼容服务器, 设置 26

D
DHCP 服务器
安装 DHCP Manager 26

创建作用域 27

设置 26

样本网络 14

DNS 表设置 29, 30

Download Drive Firmware 窗口 86

E
Enterprise Management 窗口 66

帮助 2

警报通知 70

添加存储子系统 69

SMclient 组件 33

ESM 固件
确定级别 81

下载 85

ESM 固件同步, 自动 33

ESM 固件自动同步 33

F
FlashCopy

概述 3

启用扩展许可证（高级功能部件） 102

使用 103

I
IBM 支持热线 113

Initial Setup Tasks 窗口 70

IP 地址, 指定 25

L
Linux

操作系统要求 6

磁盘空间要求 6

软件安装 45

卸载 Storage Manager 软件 53

Storage Manager 软件 45

Linux 软件包
磁盘空间要求 6

Linux MPP 安装
安装后 51

持久命名 52

构建驱动程序 50

局限性 49

内核更新 52

驱动程序安装 51

先决条件 50

卸载和重新安装 52

proc 条目 51

RAMdisk 映像 53

SUSE Linux 企业服务器 9 分发版 50

Linux MPP 软件包
安装 48

LSIMPE 设备驱动程序, 安装 56

LUN, 映射到分区 76
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LUN, 映射到分区（VMware ESX Server） 59

N
NetWare

操作系统要求 7

软件要求 6

NVSRAM 固件, 下载 84

P
proc 条目 51

R
RAMdisk 映像（initrd） 53

RDAC 软件包
卸载和重新安装 52

在 Linux 上安装 48

RDAC, 在 Linux 上安装 49

S
SAN 连接的配置（光纤通道）
设置 16

准备 16

Select Drive 窗口 87

SMagent

磁盘空间要求 5

概述 33

SMclient

磁盘空间要求 5

概述 33, 34

SMdevices 实用程序, 使用 98

SMrepassist 实用程序, 使用 99

SMutil

磁盘空间要求 5

概述 33

SNMP 陷阱 14

Storage Manager 软件
安装要求 4

除去临时安装文件（Linux） 53

辅助功能选项 111

管理员权限 5

使用安装向导（Linux）安装 47

为 Linux 安装 45

卸载组件
Linux 53

Windows 100

新安装 31

验证安装（Windows） 38

Storage Manager 软件 (续)

在集群环境中安装 41

Task Assistant 68

Storage Manager 软件 Linux 版
安装顺序 22

概述 45

管理站组件 46

主机组件 46

Storage Manager 软件 NetWare 版
安装顺序 22

Storage Manager 软件 Windows Server 2003 版
安装顺序 21

SMagent 组件 33

SMclient 组件 33

SMutil 组件 33

Storage Manager RDAC（MPIO）组件 33

Storage Manager 软件 Windows Server 2003 版和
Windows Server 2008 版
概述 32

Storage Manager Agent（SMagent） 33

Storage Manager Client（SMclient） 33

Storage Manager Utility（SMutil） 33

Storport miniport 设备驱动程序
Windows 安装 32

Windows 集群服务器安装 41

Subsystem Management 窗口
帮助 2

SMclient 组件 33

T
Task Assistant 68

Task Assistant 窗口 68

TCP/IP 协议验证
Linux 版 30

Windows 版 28

V
VMware ESX Server

管理站软件要求 58

将 LUN 映射到分区 59

配置存储子系统 58

主机软件要求 58

VolumeCopy

概述 3

启用许可证（高级功能部件） 102

使用 103

W
Web 上的互操作性列表 1
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Web 站点
订购出版物 113

支持 113

支持热线, 电话号码 114

Windows 软件, Storage Manager 32

Windows Server 2003

要求 5

DHCP 服务器
安装 DHCP Manager 26

创建作用域 27

设置 26

Windows Server 2008

要求 5

DHCP 服务器
安装 DHCP Manager 28

创建作用域 28

设置 26
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